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How to use the PawnShop software program

by Flyware Pty Ltd

Welcome to the PawnShop manual. We have strived to
make this documentation as easy to use as possible.

You can use this manual while you are beginning to use
PawnShop or refer to it when needed.
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1 Licence Agreement
PawnShop End User License Agreement

NOTICE TO USERS: CAREFULLY READ THE FOLLOWING LEGAL AGREEMENT. USE OF THE SOFTWARE
PROVIDED WITH THIS AGREEMENT (THE "SOFTWARE") CONSTITUTES YOUR ACCEPTANCE OF THESE
TERMS. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT INSTALL AND/OR USE THIS
SOFTWARE. USER'S USE OF THIS SOFTWARE IS CONDITIONED UPON COMPLIANCE BY USER WITH THE
TERMS OF THIS AGREEMENT.

1. License grant 
DESKTOP LICENCE - Upon issue of a valid REGISTRATION KEY for DESKTOP LICENCE by FLYWARE PTY
LTD to you, this EULA grants you the right to store, load, install, execute or display one copy of the
SOFTWARE on one of your computers ("DESKTOP COMPUTER") for a period determined by your
LICENCE. You may install the software on multiple DESKTOP COMPUTERS, if you share the same
database on each DESKTOP COMPUTER. If you intend to store, load, install, execute or display the
SOFTWARE on multiple DESKTOP COMPUTERS using separate databases, you need separate DESKTOP
LICENCES for each separate database. 

"Your Computer" means that the computer is wholly owned, rented or leased by you. "You" means the
company, entity or individual whose funds are used to pay the LICENCE fee.

You may not modify the SOFTWARE or disable any licensing or control features of the SOFTWARE except as
an intended part of the SOFTWARE's programming features. This LICENCE is not transferable to any other
system, or to another company, entity or individual.

2. Trial
This SOFTWARE is not free. When you first obtain a copy of the SOFTWARE, you are granted an evaluation
licence. 
Under the evaluation licence, the SOFTWARE has no functionality limitations, however only 5 Police Uploads
may be performed, 10 Clients entered and 40 Contracts entered under this arrangement. If you desire to
use the SOFTWARE after this, you must register to FLYWARE PTY LTD as described in the documentation
accompanying the SOFTWARE.
Otherwise you must remove the SOFTWARE from your system. 
You are expected to use the SOFTWARE on your system and to thoroughly evaluate its usefulness and
functionality before making a purchase. This "try before you buy" approach is the ultimate guarantee that
the SOFTWARE will perform to your satisfaction; therefore, you understand and agree that there is no
refund policy for any purchase of the SOFTWARE.

3. Ownership
The SOFTWARE is owned and copyrighted by FLYWARE PTY LTD. Your LICENCE confers no title or ownership
of the SOFTWARE and should not be construed as a sale of any right in the SOFTWARE.

4. Distribution
You may make and distribute unlimited copies of the SOFTWARE, as long as each copy that you make and
distribute contains this agreement, the FLYWARE PTY LTD PawnShop installer, and the same copyright and
other proprietary notices pertaining to this SOFTWARE. If you download the SOFTWARE from the Internet or
similar on-line source, you must include the FLYWARE PTY LTD copyright notice for the SOFTWARE with any
on-line distribution and on any media you distribute that includes the SOFTWARE.

5. Restrictions
You may not rent, lease, sub-licence, transfer, or sell the SOFTWARE. You agree not to modify, adapt,
translate, reverse engineer, de-compile, disassemble or otherwise attempt to discover the source code of the
SOFTWARE. You may not alter or modify the installer program or create a new installer for the SOFTWARE.

6. Copyright 
The SOFTWARE is LICENSED, not sold. The SOFTWARE and all rights are owned by FLYWARE PTY LTD
and/or its suppliers and are protected by copyright law and international copyright treaties. You
acknowledge that no title to the intellectual property in the SOFTWARE is transferred to you. You further
acknowledge that title and full ownership rights to the SOFTWARE will remain the exclusive property of
FLYWARE PTY LTD and you will not acquire any rights to the SOFTWARE except as expressly set forth in this
LICENCE. 

7. Termination
The LICENCE is in effect until terminated. You may terminate this LICENCE at any time by ceasing any and
all use of the SOFTWARE, and deleting or destroying the SOFTWARE. This agreement shall terminate
automatically upon breach of any term of this agreement. Upon termination you shall destroy all copies of
the SOFTWARE. Sections titled "Ownership", "Restrictions", "Copyright", "No Warranty, No Liability",
"Governing Law" and "Entire Agreement" shall survive any termination of this agreement. 
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8. No Warranty, No Liability
FLYWARE PTY LTD AND ITS SUPPLIERS DO NOT AND CANNOT WARRANT THE PERFORMANCE OR RESULTS
YOU MAY OBTAIN BY USING THE SOFTWARE OR DOCUMENTATION. FLYWARE PTY LTD AND ITS SUPPLIERS
MAKE NO WARRANTIES, EXPRESS OR IMPLIED, AS TO NON INFRINGEMENT OF THIRD PARTY RIGHTS,
MERCHANTABILITY, OR FITNESS FOR ANY PARTICULAR PURPOSE. IN NO EVENT WILL FLYWARE PTY LTD
OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL OR SPECIAL DAMAGES,
INCLUDING ANY LOST PROFITS OR LOST SAVINGS, EVEN IF A FLYWARE PTY LTD REPRESENTATIVE HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY THIRD PARTY. YOU
HEREBY ASSUME THE ENTIRE RISK OF ALL USE OF THE COPIES OF SOFTWARE COVERED BY THIS
LICENCE.

9. Entire Agreement
This is the entire agreement between you and FLYWARE PTY LTD that supersedes any prior agreement or
understanding, whether written or oral, relating to the subject matter of this LICENCE.

Copyright © 1996-2015 FLYWARE PTY LTD. All rights reserved.

FLYWARE PTY LTD
PO BOX 261
MILSONS POINT  NSW  1565
Australia



Part

II
Copyright



5 PawnShop Documentation

© 2015 Flyware Pty Ltd

2 Copyright

PawnShop User's Guide

The software described in this documentation is provided under a licence agreement and may be used only
in accordance with the terms of the agreement.

Copyright Notice

Copyright © 1996-2015 Flyware Pty Ltd.     ABN: 41 086 034 915.    All rights reserved.

Any technical documentation that is made available by Flyware is the copyright work of Flyware Pty Ltd and
is owned by Flyware Pty Ltd.

NO WARRANTY. The technical documentation is delivered to you "as is" and Flyware makes no warranty as
to its accuracy or use. Any use of the technical documentation, or the information contained in it, is at the
risk of the user. Whilst every care has been taken, documentation may include technical or other
inaccuracies or typographical errors. Flyware reserves the right to make change without prior notice.

No part of this publication may be copied without the express written permission of: 

Flyware Pty Ltd, PO Box 261, Milsons Point  NSW  1565,  Australia.

The PawnShop program is provided “as is” without warranty of any kind. Flyware Pty Ltd does not
guarantee or make any representations that the functions contained in the PawnShop program will satisfy
your requirements or that the operation of the PawnShop program will be free from interruption or error.

No oral or written advice given by Flyware Pty Ltd, its employees, distributors, dealers or agents shall create
any warranties.

Neither Flyware Pty Ltd nor anyone else who has been involved in the creation of the PawnShop program
shall be liable for any direct, indirect, consequential or incidental damage, including any lost profits or lost
data, arising out of the use of or inability to use the PawnShop program. 

Trademarks

Windows ® XP, Windows ® Vista, Windows ® 7 and Windows ® 8 are registered trademarks of Microsoft
Corporation in the United States of America and/or other countries.

Pentium is a trademark or registered trademark of Intel Corporation.

All other brand names or trademarks mentioned are the property of their respective owners and are hereby
acknowledged.
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3 Introduction
PawnShop has been designed to provide the best custom software for pawnbrokers and second-hand
dealers. It is essentially a customised database allowing you to save both client records and item records.
PawnShop complies with the NSW police regulations governing the pawnbroking industry, the Queensland
police transfer specifications and more recently, the Northern Territory police specifications. It has been
refined over many years, with new features being added at the specific request of some of our clients. It
runs under Windows XP, Windows Vista, Windows 7 and Windows 8.

  NOTE: PawnShop will not operate on operating systems older than Windows
XP.

We have made every effort to create a user-friendly program that will be easy to learn and quick to use.
This manual takes you through each procedure step-by-step, using everyday language.  We advise you to
take the time to familiarise yourself with it when you can, but we realise it may not be possible to read the
whole lot in one go!  To simply get started, check out Appendix A at the back of the manual, which is a
guide to the most useful sections (the ones you really need for your basic operations).

Please note that this help file covers both the Pawnbroking and the Second Hand Only versions of
PawnShop.

To help users of the program who are second hand dealers only and are not pawnbrokers, information in
this help file relating purely to pawnbroking is typed in a green font colour.

We hope PawnShop helps you run your business better and more efficiently.
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4 Getting Started

  NOTE: PawnShop is designed to be used primarily with a mouse, although
sometimes you can use one or more keys instead.  We recommend
using the mouse, since it is generally easier and faster to use, so we
always present the instructions with the mouse function.  If there is an
alternative keyboard function, it is presented second (in brackets).

To install or re-install PawnShop:

1. Go to the Flyware website (http://www.flyware.com.au).

2. Click on the link to go to the Downloads page.

3. Click on the icon next to Demo Version / Full Install and follow the instructions.

The installation will create a menu entry for PawnShop under Programs in your Start menu as well as an
icon on your desktop.

http://www.flyware.com.au)
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5 Preferences
Once PawnShop has been installed, there are a few things you must do to set the program up to suit your
requirements. Before you can enter clients or items, you must first add a clerk and set preferences such as
time periods and interest rates which control how the program operates.

These can be changed at any time, and may need to be updated if there are changes to the laws that
regulate the pawnbroking and second-hand dealers industries. Some of these are already set according to
the current (at the time of writing) legal requirements in NSW.

Usually, once you set these preferences, you don't need to change them very often but you should read this
section carefully so that you understand what each option does.

The Preferences window is presented in 5 different sections, or tabs:

· General General, Time Period, Payment & Numbering options.

· Contract Interest, Hold, Auction and other Contract options.

· Printing & Security Receipt & Report printing options.

· Receipts Receipt layout options.

· Other Additional options.

To open the Preferences window:

1. Go to the Options menu and select Preferences (or use the Alt + O keys to open up the
Options menu, and then press the P key).

2. The Preferences window will appear.

5.1 General Tab
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General You turn these options on by clicking in the checkbox (or use the tab key and the space
bar) – a tick will appear.  To turn them off, click (or press the space bar) again.

Activate Password: If you click in this box, you'll be prompted to enter a password each time you start
PawnShop. The procedure for entering in a new password (or changing your current password) can be found
in the Using a Password section.

Overdue Layby Reminder: If you click in this box, you'll be reminded when starting the program that
there are laybys which have passed their layby period and have not been finalised.

Allow Zero Interest Amounts: Normally, the program won't let you enter a zero interest amount. Setting
this option allows you to have interest free loans.

Show Last Amount for Item on New: Setting this option will pop up a message box every time you
enter a contract, showing the last amount you entered for the current item type and contract type. If you
haven't previously entered a contract of that type with an item of that type, nothing will occur.

For example: If you last bought a drill for $30, the next time you enter a new Buy
contract and choose Drill as the item type, a message box saying that
you last bought a drill for $30 will appear. The box will only appear for
contracts of the same type (pledge, buy and consign). So if you pawned
a drill for $20, you will see $20 on your next pledge of a drill and $30
on your next buy. See the Contract Details section for a sample.

Use Old Contract Locate Method: The program will locate contracts by matching the numbers you type.
For example, if you type 123 when locating a contract, any contract ending in 123 (2010000123,
2011004123, 2015012123 etc) will display in a search results window. Previously, typing 123 would only
locate contracts ending in 000123 (the last 6 digits would be padded out with zeros). Clicking this option
will use that method instead of the newer one.

Time Periods For the fields in this section, you type numbers in the fields on the left – click inside the
relevant fields (or use the tab key to get there) and then type. Choose days, weeks or
months from the fields on the right by clicking on the arrows and selecting with your
mouse (or use the up or down arrow keys, then tab).

  NOTE: The Pledge and Purchase periods are set up as per current (at the time
of writing) NSW legislation.

Pledges due in: This allows you to specify how long a pledged contract will be In Pawn before it is
considered overdue if no payments are made. At the time of writing, NSW State legislation specifies this
period as 3 months (NSW PAWNBROKERS ACT 1902).

Purchases due in: Here you specify the length of time that a contract must be retained before it is legal to
put it in the shop for sale. At the time of writing, NSW State legislation specifies this period as 14 days
(NSW PAWNBROKERS ACT 1902).

Laybys due in: Here you specify how long items are kept on layby before becoming overdue.

Consigns due in: This allows you to hold a consignment for a period of time before it is due to be put into
the shop.  At the time of writing, there are no regulations on this period, so you can choose how long you
want it to be.

Auct. Buys due in: Here you specify how long items bought at auction are kept before being put out for
sale. Generally this will be 0 days meaning they are due to be sold immediately after being entered.

Data Entry   This section allows you to specify how the things you type appear in the program. Just click
inside the circle to the left of your choice (or use the tab and up/down arrow keys).

You can choose between:

Normal CASE: This option allows you to add capital letters anywhere you want, and does NOT
automatically capitalise any letter.

Auto Capitals: This option automatically places a capital letter at the start of every word. However,
it will remember any capitals you type in the middle of words. For example:
PawnShop Is The Best Program For You in NSW.

ALL UPPER CASE: This option automatically capitalises every letter of every word. For example:
PAWNSHOP IS THE BEST PROGRAM FOR YOU IN NSW.

Double Enter Serial: NSW police now require entry of serial numbers via 'double blind coding'. If you are
a NSW user, you should have this option on, otherwise click it off.
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Serial # to Descr: Ensures serial numbers are copied to the Description field. This should only be turned
off if you print the serial number separately on your receipts.

Model to Descr: Ensures model numbers are copied to the Description field. This should only be turned off
if you print the model number separately on your receipts.

Others to Descr: Ensures other numbers (e.g. barcodes etc) entered in the Item Numbers window
numbers are copied to the Description field.

Database & Backups When you back up your database (which you should do regularly), you might
want to save it in the same place every time – for example, onto a USB key – or
you may prefer to use different locations. If you just want to back up to the
floppy drive, choose Always Use and type A:\PawnBack.pbu into the text
box. PawnShop will then automatically save your backups there. You can also
choose your own location if you have a zip disk, USB key or removable hard disk.
You should always name your backup location with .pbu at the end.

If you would like to specify different locations frequently, choose the Ask option, and the program allows
you to choose a location. This is useful if you backup to floppy and a hard drive regularly.

The next text box allows you to type in a location for your database when you have a network and you want
2 or more computers looking at the same database.  By clicking the … button you can locate the file
anywhere on your computer or network. Please see the Network section for more details. Unless you are
using PawnShop on a network, we recommend leaving the location as the installation folder.

Suburbs and Postcodes This section allows you to maintain the suburb and postcode list held within the
program. See Updating Suburbs and Postcodes for more details.

Shop Information This section is only used by NSW dealers. Type your company name (name on
dealer licence), branch number, and dealer licence number in the relevant fields. 
Click inside each field with your mouse to move from one to the next (or use the
tab key).  If you have only one shop, your branch will usually be 01.  This must
be entered for police data transfer.

If you click the Warn me about things relevant to NSW Police offloads check box, you will be warned
if you enter or omit details which could cause a problem when transferring your data.



14Preferences

© 2015 Flyware Pty Ltd

5.2 Contract Tab

Interest This is where you specify monthly interest rates for different pawn (pledge) amounts.

  For example: Some pawnbrokers may charge higher interest rates for lower pawn amounts.
For amounts of $10 and under they may charge 30% per month, for amounts
between $10 and $50 they may charge 25% per month, and for amounts over
$50 they may charge 20% per month.

To specify these different interest bands:

1. The first From amount is automatically set to $0 - use the mouse (or the tab key) to select
the first To amount, and type in the amount you want.

2. Use the mouse (or the tab key) to select the first Rate amount and enter the interest rate
you want. (You will notice that the next From amount will automatically become 1 cent more
than the last To amount. You don't need to edit this).

3. Use the mouse (or the tab key) to edit the remaining To and Rate amounts. When
specifying the highest amount, enter 99999.99. Currency symbols are added automatically.

  NOTE: Although the interest rate is automatically calculated, you can change
it for any item when you enter new pawn details – simply click on (or
tab to) the % Rate field and type in the rate. The interest will be
recalculated. However, you can only change the interest charged on a
pawn while you are entering its details, before you click the OK button.
If you want to change the interest rate after clicking OK, you have to
delete the item and re-enter it.

Per Period/Over Entire Contract:  These options allow you to choose whether the interest percentage is
for each period specified (day, week, month) or the whole period (7 days, 4 weeks, 2 months for example).
The annual rate calculation and label for interest on the main screen changes depending on your choice.
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  For example: You may charge 30% for contracts over 2 months; the 30% will only be
applied once over that period.  On a $100 loan, $30 will be payable as interest
over the 2 months. Alternatively, you may charge 15% per month over a 3
month contract period. In this case, $15 per month will be payable as interest
over each of the 3 months for a total of $45.

Include current day in interest calc:  This option allows you to decide whether or not to include the day
on which an item is pawned in your interest calculations.

  For example:  If an item is pawned on the 10th of the month, a client will often assume that
they will be paying a month's interest until the 10th of the following month. 
Strictly speaking, they really only have until the 9th, because the day the item
is brought in counts as the first day of the interest period.  However, by
putting a tick in this box, you can allow the monthly interest to start from the
day after the item is pawned, essentially giving your client an extra day. 
However, if they come back on the same day to make a payment, they will still
be charged a month's interest.

Hold Police occasionally have reason to put a hold on a suspected stolen item. This section of the
preferences allows you to activate this option if you want, as well as set other preferences related
to it.  As before, you click inside the check boxes or type in the relevant number.

Activate Hold Option on Contracts: When this option is selected, any item can be put on hold. When an
item has a status of Held, it cannot be sold or redeemed in the program.

Auto Activate Client Notes on Hold: Selecting this option means that the Client Notes window will
automatically be opened whenever an item is put on hold. This allows you to record details of the hold, such
as the police officer's name, the relevant police station, comments, etc. This option can only be selected
when the Hold option is activated.

Hold Item for xxx days: This allows you to select the number of days that you (or the police) want  items
to be on hold. After this time, the item will automatically go back to its original status. A value of zero (0) in
this field means that the contract will never automatically come off hold. You must do it yourself.

Overdue Items / Sales This section of the preferences allows you to specify a value over which, items are
sent to auction when they have passed their due period and shows you how the
amount owing on an overdue item will be displayed.

Send due items to shop automatically: Normally, any due items will appear in the Items Due window
and you can send to shop, auction or dispose of them in that screen. Clicking this option will send items to
shop when they become due, so you can sell them without needing to use the Items Due window.

Display amount owing at due date: Ticking this option shows the amount owing at the point an item
becomes overdue. 

Items over xxx sent to auction when due: This allows you to specify the value above which contracts
will be sent to auction when due. At the time of writing, the NSW legislation has relaxed this condition. You
may enter 99999 if you wish to sell all overdue pledges in your shop.

Sales over xxx require buyer's details: Sometimes police will require you to obtain the name and
address of a buyer of an item so it can be tracked down if it turns out to be stolen. Enter 99999 if you do
not wish to activate this feature. At the time of writing, any sale over $50.00 in NSW must have the buyer's
details (name and address) recorded.

Default payment type: This will initialise the payment type drop down boxes on the Payments and Sales
screen to the value selected in this box. Choose your most common payment method to save time when
performing a sale or payment.

Clients Here you can decide whether to enter clients' given names or surnames first, and also
if you want the program to automatically warn you if you locate a Red-graded client, or
if the client is under a certain age (you can specify this age yourself).  Leave the boxes
blank if you don't require this warning.

Payment Options This section allows you to specify whether paying interest will advance the due date of
a contract or not. If the laws in your area do not allow for changing of the contract
expiry (due) date, you should click this off.

Numbering This option allows you to specify the starting point for automatic contract and receipt
numbers.  The NSW police specifications dictate that the format for all pledges,
purchases and consignments should be the same, namely 10 digits long, beginning
with the year and then a number of zeroes. Please note that all numbers are
sequential, no matter what type of contract they represent. If you are not located in
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NSW and can have separate number sequences for buys and consignments, you can
set this up in the Other tab.

Reset Number on First Contract of the Year: When the year changes, this option tells the program to
automatically reset the sequential numbers for contracts to 1 to save you having to remember to do it each
year. If you wish to have the numbers continue each year, leave this off.

5.3 Printing/Security Tab

Printer Options If you do not choose a printer in this section, the program will use the default
Windows printer instead.

For Pledge/Buy tickets use: This allows you to specify which printer PawnShop uses to print loan and
purchase tickets.

For Sales Receipts use: This allows you to specify which printer PawnShop uses to sales and layby
receipts.

For Reports use: This option allows you to specify which printer PawnShop uses to print reports.

Show 'Change Paper' before printing reports: This option becomes available if you have selected the
same printer port to print both receipts and reports.  As your receipts will probably use a different type of
paper (for example, carbonised or pre-printed), this option warns you to change from this paper to normal
paper before printing reports, which means you don't waste your more expensive receipt paper!

Receipt Options Click any of the boxes where you want the printing to be done automatically (i.e. without
having to click the Print button). 

Add Price to Description on Sales Receipts: This option allows you to have the sale price placed with
each description on Sales and Layby receipts. Normally only the total is printed.

Add Contract to Description on Sales Receipts: This option allows you to have the contract number
placed with each description on Sales and Layby receipts.

Security Options This section allows you to place a password on the Reports and Cash Drawer
sections of the program as well as when deleting clients and items. See Using a
Password with Reports, Cash Drawer and Deleting Clients and Items for more
details.
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Receipt Comments This section allows you to enter up to two lines of comments that will appear on
every type of printed receipt. For example, you may wish to remind customers on
your receipts that exchanges and refunds are only possible if they bring their sales
receipt.

5.4 Receipts Tab

Receipt Layouts This allows you to choose what sort of layout you want to use. Using the Built-In receipt
types print on an A4 page in a pre-defined format. You can customise these by editing
the associated .rtf file for the type of receipt (pledge, buy.consign etc) See the Built-In
Receipts section for more details. The Built-In Receipt Options are used at the top of
the receipt print.

  NOTE: State Laws dictate that certain details must be pre-printed on each
receipt you issue. Some legal details can also be pre-printed on the
back of the receipt, leaving you more room on the front to print any
other details you want.

Export Custom Layout to Text File… This will export your custom receipt formats to a comma delimited
file which you can edit or view in Notepad. If you don't have custom receipts installed, it will export the
centre aligned formats for you to edit or view. See the document titled 'Custom Receipt Formats.doc' in your
installation folder for information on modifying the exported file.

Import Custom Layout from Text File… This is how you get your changed receipts back into the
database. Pressing this button will warn you to do a backup before proceeding. If you have made a mistake
in your text file, you may lose you custom receipts!

  WARNING: It is HIGHLY recommended that you perform the backup when doing
this. Do not attempt to import receipt formats unless you are
confident that you know what you are doing!

Receipt Copies
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Print X pledges/buys/sales/payment This allows you to determine how many copies of each print type
are done each time you press print. If you have set tickets/receipts to print automatically, the number of
copies printed will be determined here too.

5.5 Other Tab

Reports

Separate pledges/repledges on reports: This option allows you to choose whether or not repledges and
rebuys (contracts that are redeemed and then brought back into your shop) are shown separately in the 
Outgoings report. This is done by showing contracts as Pledges / Repledges and Buys / Rebuys.  If this
option is not ticked, all contracts will appear as Pledges or Buys in the reports.

Separate sales items on income (excl. laybys): This option allows you to choose whether or not sales
are shown on the income report item amounts separate or not. If this is off, a sale will be shown with the
total sale amount rather than each item amount.

Backups

Remind me to backup upon exiting: This prompts you to backup when closing the program.

Remind me to test backup afterwards: This prompts you to test the backup after it has been created.

  NOTE: We recommend you use a USB memory key or removable hard disk to
store your backup. This can be stored offsite for extra security from
theft or fire.

Auto Backups: This option allows you to specify whether regular backups are made to your hard disk
automatically during the day. The auto backups are saved in your TEMP folder. You should see your
computer technician if you do not know where this folder is located.

Note that this option is not a replacement for your nightly backups to a removable disk. If your entire hard
disk crashes, your auto backup will also be lost. See Backups and Restores for more information on
backups.
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Every XX minutes: Allows you to choose the duration between auto backups.
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Police Printout

Manual Nums: Normally only auto numbered items are printed in the Police Printout. If you want items
which were assigned a manual number to be included, click this option.

Sale Amts: If you need amounts for your sales to be included on the report, click this.

Loan/Buy Amts: If you need amounts for your loans and buys to be included, click this. 

Sort Police Printout by Contract Type/Number: You can choose to have the contract types grouped
together or just have a sequential list of contracts. If grouping by type, you can use Page Break between
types to ensure each new type begins on a new page.

Addresses

Use all address fields: If this option is selected, the program will advance to all address fields (unit,
postcode etc), in the client details section. This is the option normally used by the program.

Skip the following address fields: This option is useful in areas where some address fields are not used.
By ticking a field, it will not be tabbed to when entering/editing a client's address.

Use O/S as default address type:  If you are not a NSW user of the program and are not required to
provide all your address details separately (eg street number, name, type, suburb etc), you may wish to
enter all your addresses as free text. Choosing this option will allow this. When you click this option on, the
program will ask if you want to convert all your existing addresses to free text as well. NSW users should 
NOT use this option unless you deal exclusively with overseas clients.

Police Offload If you want your police offloads to go to the floppy disk, choose Always Use This
File and type A:\PawnData.txt into the box. You can use C:\PawnData.txt to go
to the hard disk each time. If the filename you have chosen already exists when you
run a police offload, you'll be prompted to overwrite it or given the chance to move it
and try again.

By choosing Ask, the program will prompt you for the filename each time you run a
police offload or resupply. Use this option if you want to save your police files to
different filenames (e.g. you might use the date as part of the file name).

NSW User: If this option is set on, there will be warnings, restrictions and limitations in the usage of the
program as set by the NSW police.

Use Offload For: Allows you to offload to the NSW or Queensland police file format.

Client Numbers

Use Client Numbers: This shows a client number box in the client details section on the main screen. It
allows you to use the client number which is internally generated, or to overwrite it with your own. You can
then locate clients using this number instead of their name.

Additional Numbering

These options allow you to specify a different numbering scheme for purchases and consignments when
using auto numbering. Note that these should NOT be used in NSW.

If you use the Use Separate Purchase Numbers option, a B (for Buy) will be placed in front of the
auto-generated number. A C (for Consignment) will be placed in front of the number if you use the Use
Separate Consign Numbers option. This is so that you don't have duplicate numbers in your system.

Using these options allows you to have a contract with number B000111 and C000111 in your system.
Normally the number 000111 would only be used once each year.
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6 Clerks
Clerks are the names of the staff members using the program.  The PawnShop program requires this
information, as it attaches the name of a clerk to every contract that is entered into the database.  Before
you can start putting in any other information, you have to enter the names of the people who will be using
the program.

The Clerk Maintenance window is used to add, edit and delete information about your clerks.

Topics in this section:

Adding a New Clerk

Changing/Deleting Clerk IDs

6.1 Adding a New Clerk

To add your clerks:

1. Go to the File menu and select Manage Clerks (or use the Alt + F keys to see the File
menu, then the down arrow key to get to Manage Clerks, then the Enter key).

2. The Clerk Maintenance window will appear.  The first time you open it, there will only be
one  blank line displayed.

3. Click in the Name field and type in the name of one of your staff.

4. Click the square box (called a checkbox) in the Active column with the mouse so that a tick
appears.

  NOTE: If a staff member is sick or on holidays, you can keep their ID inactive
by clicking this field off for the period they are away. This prevents
other clerks choosing it by mistake when entering new
contracts/payments/sales.

5. Type in the staff member's date of birth and address in the next two fields. This is only
required in NSW. 

6. Enter the date the clerk started working in the business in the Start Date field and if they
stop working at any time (permanently) enter the date they stop in the End Date field.

7. Click in the Name field on the next line and repeat the procedure for each member of staff.
A new line will appear for each one as you begin to type.  You can put in all the names of
your staff at any time by returning to the Clerk Maintenance screen.
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You can also use the Print button to generate a report of your staff. This report may be requested by police
if you operate in NSW and is provided to comply with legislation at the time of writing.

6.2 Changing/Deleting Clerks

To change or delete your clerks:

1. Go to the File menu and select Manage Clerks (or use the Alt + F keys to see the File
menu, then the down arrow key to get to Manage Clerks, then the Enter key).

Just as you can add new clerk details in the Clerk Maintenance window, you can also delete or change
these details if and when you need to.  You can make a clerk inactive if they are absent temporarily, by
simply clearing the Active checkbox.  

If a staff member moves house, you can return to the Clerk Maintenance window and type in their new
address.  Just highlight the old address by clicking in that field, and type the new one.

Finally, if someone was entered in error, you can remove their details from the Clerk Maintenance window
by highlighting the whole line of information about that person (click with the left mouse button on the
arrow at the beginning of the line) and then pressing the Delete key on the keyboard.  You can only do this
if the clerk does not have any contracts, payments or sales attached to them.

Depending on your location, you may be required by law to leave details on this screen after a clerk stops
working at your business.  In this case, uncheck the Active checkbox and they will be removed from the
clerk list when performing new contracts, payments and sales.
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7 The Main Window

This is the main window of PawnShop, which displays all details about clients and items, as well as providing
the launching point for many other features of the program, such as Reports, Items Due Window, Sales
Window, etc.

The Main window is composed of the following sections:

Client Details

Contract List

Selected Contract Details

Contract Item Details

Status Bar

Tool Bar & Buttons

Sale Details
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7.1 Client Details

In the Client Details section you enter a client's full name (given and surname), address, phone number,
date of birth, and identification. See the Client Details section for more details on this topic.

Any of these details can be changed. When you change something, simply click on the OK button on the
Main window to save the change.

7.2 Contract List

The Contract List section (located in the upper right part of the screen) contains a list of all the selected
client's items. This section contains 4 columns of information:

Cont: Contract number.

Date: The date that the contract was submitted.

Item Name /
Description:

The name or the full description of the first item in the contract (depending
on the Show Description in Contract List menu item under the Options
menu).

Status: The current status of the contract.

7.3 Selected Contract Details
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The Selected Contract Details section consists of:

Type: Either Pledge, Buy, Consignment or Auction Buy (depending on your version of PawnShop,
some of these may not appear).

Clerk: The name of the person performing the transaction.

Date: The date and time the contract was created.

Contr: The contract number.

Past: If the current contract is a repledge (one that has been redeemed and the same items are
brought back again), clicking this button will show the list of original contract number(s).

7.4 Contract Item Details

The Contract Item Details section consists of:

Item: The item number within the contract.

Description: The full description of the item including serial numbers and comments.

J/G: Indicates whether the item is Jewellery or General. Note that when you enter a new
item type it will ALWAYS be marked as General. You cannot add a Jewellery type.

Amount: The amount allocated to the item. For a pledge, this will be the loan amount for the
item, for a buy, it is the amount paid and for a consignment, it is the amount that the
person expects to receive after sale. You will need to allow for your margins on top of
this amount.

The details below this grid vary depending on the type of contract you are entering. For a loan, the
following appear:

Remove Item: Click this button to delete an item from the list (only when entering
contracts).

Repledge: Displays whether the item has been repledged.

Owner: Is the client the owner of the item or not.

Acquired On
Site:

Shows if the contract was obtained on your premises or not.

% Rate: The monthly interest rate for pledges.

Ann. % Rate: The annual interest rate charged on the contract.

Mon. Int: The monthly interest amount of the contract. This is automatically calculated
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and cannot be changed.

Due Date: Automatically displays the due date of the contract (after you click OK).

Total: Shows the total amount for all items in the contract.

Customs Ref: NSW Police require a customs reference to be supplied for all imported goods.

See Consignments for other fields that appear here.

7.5 Status Bar

The Status Bar runs along the base of the Main window, and displays information about either the current
client or about what the program is doing.  The display changes according to which part of the program you
are running.

Sample Status Bar

Program Function in Status Bar

Client/Contract Details in Status Bar

The following information is displayed:

Program
Information:

What the program is doing or relevant information. eg. New Item, Locate
Client etc.

 Client Details:
Items:

Paid:
Owing:

The current financial details of the client.
Total lent to the client on all pledges.
Total interest paid by the client on all pledges.
Total owing on all items.

Item Details:
Paid:

Owing:

Information about one particular contract.
Shows how much has been paid on the current contract.
Shows how much is still owing on the current contract.

Rating: Shows how you have graded customer.

Item Notes: Displays in red if there are special notes about the current item.

Client Notes: Displays in red if there are special notes about the current client.

Manual Item #s:
Auto item #s:

Displays the current item numbering system selected in red.

Time: The current computer date and time.

Time and Date

The current time and date are displayed on the far right of the status bar. This is based on your computer's
system time.  Every transaction automatically uses the current time and date, unless you manually change
them.

  NOTE: For PawnShop to operate correctly please ensure that your Control



29 PawnShop Documentation

© 2015 Flyware Pty Ltd

Panel date settings are set to the format dd/mm/yyyy (i.e.
14/12/2005, and not 14/12/05). This allows PawnShop to display the
entire 4-digit year, which means the program will operate correctly.

  NOTE: You should also use AM and PM as your am/pm symbols for the Time
Settings in Control Panel.

Financial Information

All financial information about a client appears in the Status Bar.

The information consists of:

Items: The total value of all items attached to the client (pledge amounts + purchase
amounts). Consignment amounts are not included.

Paid: The total amount of money that has been paid by the client (pledge interest and
redeem payments).

Owing: The total amount the client still owes.

Also, all financial information about each contract appears in the Status Bar.

This information is:

Paid: The total amount that has been paid on this contract

Owing:
The total amount still owing on this contract

Customer Grading

The Red, Amber, Green, New options represent a unique customer grading system that may be useful to
you. They graphically represent a customer's ability to pay money owing and/or redeem pledges.

Look out for this client!

Naturally, red represents a 'bad' client, amber an 'average' client, green a 'good' client, and 'New' a first-
time client. 

  NOTE: The initial setting is "New", as this will be the one you use most frequently.

7.6 Tool Bar and Buttons

The tool bar is located down the left-hand side of the main window, and provides buttons that activate the
most commonly used functions of the program.

Clients Button:
Click this button to create a record for a new client or to find a client by entering
client name(s).
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Items Button:
Click this button to record details of a new contract (Note: a client must be loaded
first), or to find a contract by entering its number when no client is loaded.

Search Button:
Click this button to search your records clients / contracts matching particular
information.

Items Due Button:
Click this button to display the Items Due window.

Sales/Auction Button:
Click this button to display the Sales window.

Reports Button:
Click this button to display the Reports window.

Help Button:
Click this button to display the online PawnShop help file.

Police Button:
Click this button to create a disk for the police. This is applicable to shops in NSW and
Queensland only.

7.7 Sale Details

This section is only activated when an item is ready to be sold, or has been sold (see Overdue Contracts
and Sales and Auctions for full details).

The information included here is:

Shop # If you assign a new number to an item which is to be sold in your shop (not related to its
contract number), you can enter it here.

Shop $ The amount you advertise an item for sale in your shop. This will be the sale amount
unless you change it when performing the sale.
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Sale $ The amount an item was sold for. (Display only)

Disc. Discount given, if any. (Display only)

Profit The amount of profit you make on the sale (the difference between the price you
originally paid for the item and the amount you sold it for, not including any interest
payments). (Display only)

Date Date of the sale. (Display only)

The only parts you can type in are the Shop # (number) and Shop $ fields – the rest is all calculated
automatically, where applicable, when an item is sold.
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8 Client Details
Clients are people you buy items from, sell on consignment for or loan money to. When you sell an item in
your shop, and you enter the buyer's details in the Sales window, the buyer will also be added as a client,
so their details will be available if they happen to come in and sell something to you.

This section deals with adding a client to your system. To locate and edit an existing client, see the Locating
Clients and Items section.

Topics in this section:

Adding a New Personal Client

Adding a New Organisation

Adding Identification

8.1 Adding a New Personal Client

To add a new personal (non-business) client:

1. Click the Clients button.
(or use the Ctrl + L keys).

2. The Main window will clear and the cursor will be flashing at the beginning of the first name
field, ready for you to start typing. Type in your customer's first name(s), then click inside
the next field with your mouse (or use the tab key) and type the surname.

  NOTE: If you prefer, you can opt to enter the surname of a client in the first
field, and the given name(s) in the second field. This is done in the
Clients section in the Contract tab of the Preferences window.

3. The words in the names & address fields will be automatically capitalised if you have chosen
the Auto Caps option, or all UPPER CASE if you have set that option in the Data Entry
section of Preferences .

4. When you have finished typing in the client's name, click OK (or use the F12 key). If you
have no previous record of this client, you will see the message: "No results matched your
criteria" and you are asked if you want to create a new client record. Click Yes (or use the Y
key).

  NOTE: If the client's record already exists, their details will appear
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automatically when you click OK (or use F12).

5. Continue entering information, one field at a time. You can click inside a field using your
mouse (or you can use the Tab key to move forward, Shift + Tab to move backwards), and
then either type in the information required, or select from a list.  You can leave some fields
blank if they do not apply – just ignore them (or tab past them).

6. If the person you are dealing with is from a company, you must enter their company's details
first.  To do this, see the Adding a New Organisation section. After you do this, the person
representing the company must be entered as a separate client and you can choose the
company you entered previously from the list in the Org field.

7. Then you can choose to enter the client as an overseas client or local. If you are in NSW and
your client has an Australian address, do not use the O/S check box! You must enter the
address in the separate boxes as described further on. If the client presents an overseas
address, and you click the O/S box on, you will see a large 'free text' box to type the
overseas address as shown here. You may type the full address in this box. Non-NSW users
may use this as their default address entry by setting the Use O/S as default address
type option on the Other tab in Preferences.

Otherwise, you will need to enter the address in the following boxes. The first line contains a
property name. Enter this if there is no street number for the address, for example, if the
client lives on a rural property. 

The next line of the address contains 3 fields: 

Unit: for unit number – leave it blank if the client lives in a house

From: for street number

To: for a second street number

For example: If a client lives at 3/21-25 Wood St, you would enter 3, 21 and 25 in
the three separate fields. If the address only contains a street
number, only enter a number in the second field and leave the other
two blank.

8. Some of the fields (for example, street types), have arrows pointing down at the end.
Clicking on the arrow (or using Alt + the down arrow key) will reveal a list of words in that
category – chances are, your street type will already be there, so just type the first letter or
two and click on the word when it appears (or use the up/down arrow keys to move
through the list, then Enter). If, for any reason, it is not there, you can type it in, and the
program will ask you if you want to add it to the list.  Click Yes (or use the Y key).

9. The suburb field generates a list of all Australian suburbs, states and postcodes – as you
type, the list appears.  You just click on the correct suburb, then Select (or use the
up/down arrow keys and then Enter) and the suburb, state and postcode will
automatically go into the appropriate fields, and the list will disappear.  You can use Suburb
Maintenance on the General tab of the Preferences window to create your own list of
suburbs.

  NOTE: The suburb field changes; as you locate "GREEN POINT" – notice how
we have only typed in the first few letters. From here you would click
on GREEN POINT (2251), which highlights it, then the Select button.
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  NOTE: As an alternative to clicking on the name of the suburb and then on the
Select button, you can just double-click on the name of the suburb
instead.

8.2 Adding a New Organisation

You may choose to enter a client that is an Organisation or company. Note that if you are in NSW, you are
not permitted to assign contracts directly to organisations; you must attach a personal client to the
organisation as described below.

To add a new organisation client:

1. Click the Clients button.
(or use the Ctrl + L keys).

2. The Main window will clear and the cursor will be flashing at the beginning of the first name
field, ready for you to start typing. Type in the organisation's name in the first name box.

  NOTE: Regardless of whether you normally enter given or surnames in the
first name box, you always use the first box to enter an organisation



36Client Details

© 2015 Flyware Pty Ltd

name.

3. When you have finished typing in the organisation's name, click OK (or use the F12 key). If
you have no previous record of this client, you will see the message: "No results matched
your criteria" and you are asked if you want to create a new client record. Click Yes (or use
the Y key).

  NOTE: If the record already exists, their details will appear automatically
when you click OK (or use F12).

4. Continue entering information, one field at a time. You can click inside a field using your
mouse (or you can use the Tab key to move forward, Shift + Tab to move backwards), and
then either type in the information required, or select from a list.  You can leave some fields
blank if they do not apply – just ignore them (or tab past them).

6. You need to tick the Organisation checkbox to let the computer know you won't be
entering a surname or date of birth.

7. Then you can choose to enter the client as an overseas client or local. If you are in NSW and
your client has an Australian address, do not use the O/S check box! You must enter the
address in the separate boxes as described further on. If the client presents an overseas
address, and you click the O/S box on, you will see a large 'free text' box to type the
overseas address as shown here. You may type the full address in this box. Non-NSW users
may use this as their default address entry by setting the Use O/S as default address
type option on the Other tab in Preferences.

Otherwise, you will need to enter the address in the following boxes. The first line contains a
property name. Enter this if there is no street number for the address, for example, if the
client lives on a rural property. 

The next line of the address contains 3 fields: 

Unit: for unit number – leave it blank if the client lives in a house

From: for street number

To: for a second street number

For example: If a client lives at 3/21-25 Wood St, you would enter 3, 21 and 25 in
the three separate fields. If the address only contains a street
number, only enter a number in the second field and leave the other
two blank.

8. Some of the fields (for example, street types), have arrows pointing down at the end.
Clicking on the arrow (or using Alt + the down arrow key) will reveal a list of words in that
category – chances are, your street type will already be there, so just type the first letter or
two and click on the word when it appears (or use the up/down arrow keys to move
through the list, then Enter). If, for any reason, it is not there, you can type it in, and the
program will ask you if you want to add it to the list.  Click Yes (or use the Y key).

9. The suburb field generates a list of all Australian suburbs, states and postcodes – as you
type, the list appears.  You just click on the correct suburb, then Select (or use the
up/down arrow keys and then Enter) and the suburb, state and postcode will
automatically go into the appropriate fields, and the list will disappear.  You can use Suburb
Maintenance on the General tab of the Preferences window to create your own list of
suburbs.
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  NOTE: The suburb field changes; as you locate "GREEN POINT" – notice how
we have only typed in the first few letters. From here you would click
on GREEN POINT (2251), which highlights it, then the Select button.

  NOTE: As an alternative to clicking on the name of the suburb and then on the
Select button, you can just double-click on the name of the suburb
instead.

10. There is no need to enter the Date of Birth for an organisation, so that field is disabled for
these types of client.

11. If you are in NSW, you should enter the Identification for the client as the ABN for the
organisation. See the Adding Identification section.

12. Once you have completed the above steps, you should enter a personal client for the person
you deal with in the company and choose this company from the Org. drop down box.

8.3 Adding Identification

To add identification for a currently loaded client:

1. Click the Identification button (or tab onto it and then use the Enter key), another
window pops up.  This allows you to enter up to three forms of ID per client.
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2. As before, the fields with down-arrows at the end contain the most commonly-used types of
ID (and issuers), so scroll down the list by clicking your mouse cursor on the down-arrow (or
use the Alt + up/down arrow keys).  If you don't find what you're looking for, just type in
whatever you want and when you have finished entering all the other details, the computer
will ask you if you want to add this ID type (or issuer) to your list for next time – of course,
you should click Yes (or use the Y key) when this happens.

3. The name you typed in the Client Details section will be copied directly into the Name field
here – this saves you having to type it in again.  In most cases, the names are the same.
However, sometimes people use nicknames, shortened forms (like "Bob") or second names;
in this case, you will need to edit the name until it is exactly as it appears on the form of ID.

4. The check boxes at the bottom of the window can be clicked on or off, (or tab to each one
and then use the space bar), making a tick appear or leaving the box blank, according to
whether the ID has an address, photo, signature or date of birth on it.  

5. To enter a second or third form of ID, click inside the ID 2 or ID 3 circles at the top of the
window (or use the F7 or F8 keys).

6. If you have a digital camera or scanner, you can load a photo of the client into the
Identification window. If you have a digital camera, click the Show View button and you
will see the view that your camera's viewfinder is displaying in a separate window. When you
are happy with it, click the Take Photo button. If you have a scanner, you must save the
file in a suitable graphics format (JPEG, BMP etc). Then click on the Load Photo… button
and locate the file. Your photo file will then be displayed. Note that only the file name is
stored in the database, so you must keep the file in the selected location at all times.

  NOTE: The NSW police data offload will only copy the first two ID records.
Make sure that you enter the most important IDs in spaces 1 and 2.

7. Click the Save & Close button (or use the F12 key).

  NOTE: If you have enabled the Client Numbers option in Preferences, you will
see another box in the Client Details section. It will be filled with the
next client number when you add a new client, but you may use your
own number to change it.
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9 Contract Details
Contracts (pledges, purchases or consignments) are linked to the current client.  Information that is
recorded with each new contract includes contract number, date and time, amount lent/paid, status of
contract, and, where relevant, due date, % interest rate and monthly interest amount.  When contracts are
added, PawnShop automatically calculates such things as due date and monthly interest (if relevant), based
on the values you set in the Preferences section.

Contracts are made up of one or more items which you either buy from, lend money on or sell on behalf of a
client.

Topics in this section:

Adding a New Contract

The Item Details Window

Adding Jewellery Details

Finishing the Contract

Consignments

Viewing Contract Details

The Copy For New Option

The Copy From Option

Number Allocation

Item Hold

9.1 Adding a New Contract

To enter details of a contract, first locate an existing client or add a new client. Then: 

1. Click the Items button.   

(or use the Ctrl + I keys).

2. The Selected Contract Details section will become available for use.

3. Select the contract type (Pledge, Buy, Consign or Auction Buy) from the list. Do this by
clicking on the arrow with your mouse (or by using the up/down arrow keys, then the tab
key to move on. Depending on the version of PawnShop you have, some of these contract
types may not be available.

4. Select the name of the clerk in exactly the same way. If there is only one clerk in your
database, it will be selected automatically when you start a new contract.

5. The current date and time is automatically generated. If you want to change these details,
you can.  When you click inside the date field (or tab to it), the date format changes to
double digits with slashes separating the day, month and year (for example, 12/12/05).  You
can alter any part or all of this date; just remember -

· type a zero before any single digits for dates and months
· you do not need to type the slashes; they are already included



41 PawnShop Documentation

© 2015 Flyware Pty Ltd

  NOTE: If your system uses American date formats, when entering the date,
remember the order is month/day/year.

6. If your numbering system is set to Automatic, the contract number is automatically
generated, and cannot be changed unless you do it manually. It will appear in the
appropriate field later on; for now, ignore (or tab past this field).

7. Click in the Contract Item Details section, (or tab to it). The Item Details window will
appear.

9.2 The Item Details window

1. You are now going to choose the item type in the single field marked Item Type between
the Client Details and the Item Details (the cursor is flashing in this field).  Look through
the list of item types first, by clicking on the arrow (or using the Alt + up/down arrow
keys), to see if the one you want is already included. If it is there, select it; if not, type it
and the program will ask you if you want to add it to your list. Click Yes (or use the Y key). 



42Contract Details

© 2015 Flyware Pty Ltd

  NOTE: Remember that you are only entering the type of item – no specifics
yet!

2. Now click (or tab) to the next field – you are now inside the General Tab. The first four
fields in this part are for General items, which means anything that is not jewellery. The 
Description and Item Amount fields are for all item types. 

3. Now you type in the brand and model of the item, if there is one. For most jewellery, you
won't have values to type here.

4. If there are no serial numbers on the item, click the No identifying numbers appear on
item check box. This will tell the program to disable the serial number entry. If that check
box is off, and you are a NSW user, a new window will open when you tab to the serial
number field as shown below. The police have mandated that serial and barcode numbers be
double 'blind' entered. This hides what you type and you must type it twice exactly the same
before the program accepts it. If you are outside NSW, you can just type in the serial
number box on the In Item window.

Clicking OK when you have entered the number twice will display it in the list box at the top
of the window. Then click Close to return to the Item Details window.

5. If the item is inscribed, type it in the Inscription field, otherwise just click in (or tab
through to) the Description field. The name of the item (e.g. Watch) will appear, and you
can then type in anything else you would like to appear on the receipt. 

  NOTE: The text in the Description box shows on printed receipts you give the
client. 

6. Enter the Item Amount.  You don't need to put in the dollar sign or decimal point. For
consignments, this is the amount you expect to give the client, there is nothing holding you
to this amount. For buys, it is the amount you are paying the client and for loans, it is the
amount you are loaning. All of these are for the current item, so if you agree on say, $500
for a contract with 3 items, you need to assign separate prices for each item.



43 PawnShop Documentation

© 2015 Flyware Pty Ltd

9.3 Adding Jewellery Details

1. For jewellery items, you then click on the Extras tab (or if you use the tab key after
entering the amount, the program will advance to it). Here you can enter information such as
material, carat, stones etc.  You do not have to do this while the client is in the shop; you
can enter this information later. What you typed in the Description field will appear on the
receipt – none of the information in the Extras tab does. See the picture below for an
example of the kind of details you can enter for a watch.

IMPORTANT NOTE ABOUT JEWELLERY FOR NSW SHOPS:

When entering jewellery items, you must select one of the following options:

• Anklet

• Bangle

• Bracelet

• Brooch

• Chain

• Charm

• Cufflinks

• Earrings

• Gemstone

• Necklace

• Pendant

• Ring

• Stop Watch

• Tie Pin

• Watch

These categories are specified by the NSW Police, and every item of jewellery must be entered in one of
them. It is very important that you do NOT type in anything different, as this will not only contravene police
requirements, it will also register the item as "general", not as jewellery, and you will not be able to use the
"Extras" tab.  Please contact Flyware if you have any other jewellery types that are not listed.

  NOTE: Each jewellery item has different properties, so not all Extras tabs look
the same. You can use the Append Jewellery Details to Description
button to copy all the data from the Extras tab into the item description
box on the General tab. You can then modify the description as you like.
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9.4 Finishing the Contract

1. To enter another item in the same contract, click Next (or use the Alt + N keys) and repeat
the steps.

2. If the client changes his/her mind right in the middle of the transaction, clicking Reset (or
using the Alt + R keys) will clear the current item from the screen, Cancel (or the Esc key)
will clear all items. You will need to press Cancel on the Main window to cancel the
transaction.

3. Click OK (or use the F12 key) to finish if there are no more items.  You will be returned to
the Main window.

4. Check that the information you have entered is correct, in the Contract Item Details
section (see picture below).  If anything is wrong, you have to double-click (or use the Ctrl
key and a number – 1, 2, 3 etc - corresponding to the number of the item) for the In Items
window to reappear and to make any changes.

5. The % Rate and Mon. Int. (Monthly Interest) are automatically calculated, based on the
values you specify in your preferences.  Most of the time, you do not need to do anything to
them.

  NOTE: If you want, you can type something different into either of these
fields.  For example, you may have a flat monthly interest amount for
particular items, or you might want to give special clients a lower
interest rate. In either of these cases, after closing the In Item Details
window, just click on (or tab to) the field you want to change, and type
in the new amount or rate. If you change the % Rate, the Mon. Int. will
change accordingly, and vice versa.

6. Tick the Repledge box by clicking in it (or by using the space bar after tabbing to it) if the
contract has been submitted before. This is ticked for you if you use the Copy for New
function.

7. Only remove the tick in the Owner box if the client tells you the items belong to someone
else.  You do this by clicking inside it (or by using the space bar). If you are taking
possession of the goods at a place other than your business premises, click the Acquired On
Site check box off.

8. When you've finished, click the OK button on the Main window (or the F12 key).

9. The details of the transaction (including only the name of the first item) will now appear in
the Contract List at the top right of the Main window.
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  NOTE: Depending on your business, you may prefer to see all items in the
Contract List or just the most recent ones.  We have incorporated an
option to show only the items from the last 6 or 12 months in the
Contract List, if this is your preference.  To do this, simply go to the
Options menu and select either Only Show Last 6 Months' Contracts or
Only Show Last 12 Months' Contracts.  This option can be changed at
any time.

10. The Due Date now appears in the Contract Item Details section.  This is automatically
calculated and you cannot change it. The contract details are now saved to the database.

9.5 Consignments

When you select the contract type Consign, some extra fields appear in the Main window.

· The Amount Wanted goes in automatically when you enter the amount in the usual way.  

· You can type in the Due Sales Date, as this will be a date agreed upon by you and the client.  

· The third field (Amount Refunded to Owner) and the checkbox only become available when the item
has been sold.

9.6 Viewing Contract Details

You can look at the full details of any contract at any time. These details are displayed in the Contract
Item Details section.

To view the details of any item:

1. Locate the contract you want by clicking on the Items button when there is no client
displayed and entering the contract number.

2. The details of this contract are displayed in the Contract Item Details section.

or

1. Locate the client of the contract you want.

2. Use the mouse to select the contract from the Contract List.

3. The details of this contract are displayed in the Contract Item Details section.
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9.7 The Copy for New Option

When a contract is repledged (picked up by the client and brought back again later), it can be
time-consuming to have to put all the details back into the computer, one by one, just as you would for a
new contract.  PawnShop lets you copy the details of contracts that have been pledged before in a few
simple stages. 

For example: If a client continually submits an electric drill for pawn and picks it up
by paying the principal + interest, instead of retyping all the details of
the drill, follow these instructions.

To use the Copy For New function:

1. Locate the client (with the contract you want to copy from)

2. Either go to the Edit menu and choose Copy For New or use the right mouse button to
select the contract you want from the Contract List section.

  NOTE: You must select a contract that is out of pawn (i.e. has a status Out
Pawn), as it would be impossible for a client to repledge one of their
contracts that is currently in pawn. If you want to copy a contract's
details which is not Out Pawn, use the Copy From option described in
the next section.

3. The Right Mouse menu appears.

4. Select the Copy For New option from this menu. The details of each item in the contract will
automatically appear in the Contract Item Details section.

  NOTE: You will notice that the Repledge check box is automatically ticked and
disabled.

5. Select a clerk (and contract number if Manual Number Allocation is selected), and change
any other details you want.

6. Click the OK button.

7. The item details are copied and the original contract number appears when you click the
Past button in the Selected Contract Details section.

9.8 The Copy From Option

Sometimes you may want to copy details of a contract that is not being pledged by the same person who
originally brought it in.  As long as you know the original contract number, the Copy From… option gives
you the ability to copy details for contracts even if the owner changes, so for any contract that you
recognise as one that has been in your shop before, you'll be able to locate the old record and copy it,
instead of typing in all the details again from scratch.
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  NOTE: If you don't know the original contract number, you can locate it using
the Search function.

To use the Copy From… function:

1. Start a new contract for the client in the usual way.

2. Go to the Edit menu and select the Copy From… option. 

3. A box appears - type in the contract number of the item you want to copy.

4. Click OK.

5. The contract details are copied.

6. Choose a clerk and continue in the usual way.

9.9 Number Allocation

Contract numbers are critical to the functioning of the program and serve to identify and differentiate
contracts and items. You have the option of two types of number allocation:

Auto Contract Number Allocation is the quickest and easiest system to use. This option automatically
assigns a number to each new contract, and each item within a contract. New contracts are always given a
number that is one number higher than the last, whether they are pledges, purchases or consignments (To
reset this number see Contract Preferences: Numbering). 

However, there may be times when you want to enter an item number out of sequence.  In this case, you
can select Manual Contract Number Allocation.

Manual Contract Number Allocation is useful if you choose to skip item numbers or enter items out of
sequence, or item numbers that are not current.

  For example: When you start using PawnShop, you may want to retain your book
work and receipts until you are more familiar with the program.
Manual Contract Number Allocation gives you the flexibility to skip
entering a whole day's contracts and then come back to them later
without creating problems with your numbering system.

  NOTE: To do this you will also need to carefully backdate all contracts when
you finally enter them (for the due date and amount owing to be
correct).  Once you are up-to-date, we recommend you return to
Automatic Number Allocation.

  NOTE: For NSW users, the program will only send contracts with numbers in
the correct NSW police format in a police load. The correct format is
YYYY000000 where YYYY is the four digit year followed by six digits
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afterwards. If your manual number is not in this format, it will NOT be
transferred to the police.

You can alternate between these options at any time.

To select or alternate between them:

1. Go to the Options menu (or use the Alt + O keys) and click on either Auto Allocate
Contract Nos or Manually Allocate Contract Nos.

Whichever option you select is displayed with a tick beside it in the Options menu, and in the status bar in
red.

Alternatively, you can just double click on the numbering system you want to use in the status bar on the 
Main window to change it.

9.10 Item Hold

Due to the regulatory nature of running a pawnbroking or second-hand dealer's business, you may
occasionally be requested by the police to place an item on hold.  When you do this, its status will change
to Held and payments can be made on it, but the client cannot redeem it. PawnShop allows you to set your
Hold options, including how many days to keep items on hold, and whether the Client Notes window pops
up automatically when you put things on hold.

You can put any item on Hold unless it has been sold, auctioned or redeemed. This includes all pawns, buys
and consignments (including those that have a status of Due Shop, Due Auction or even In Shop or In
Auction).

To put an item on Hold:

1. Locate the contract.

2. Right mouse click the contract in the Contract List to show the Right Mouse menu.

3. Select Put on Hold.
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  NOTE: If you want, you can make the Client Notes window automatically
appear when you put an item on hold (see Contract Preferences – Hold
Option). Then you can record certain details (e.g. the name of the
policeman ordering the hold) straight away.

The status of the item now reads -HELD- in the Contract List.

To take an item off Hold:

1. Locate the contract.

2. Right mouse click the contract in the Contract List to generate the Right Mouse menu.

3. Select Take off Hold.

The contract now returns to its original status.

  NOTE: If you set up a hold period (ie. not zero) in Preferences, the item will
automatically come off hold after this period has elapsed.



Part
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Locating Clients and Items
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10 Locating Clients and Items
Before you can perform any transactions, there must be a client to link the transaction to.  When you locate
a client, all their details appear.  A history of the client's contracts appears in the Contract List and details
of the last contract made are displayed in the Selected Contract field.

Topics in this section:

Locating by Client Details

Locating by Contract Number

Changing Client and Item Details

The Search Window

10.1 Locating by Client Details

To locate a client by name:

1. Click the Clients button on the tool bar (or use the Ctrl + L keys).

2. The easiest way to locate a client is by entering their name (given, surname or both).

3. You can enter their client number instead if you use it in the program.

4. When finished, click the OK button, (or use the Ctrl + Enter keys).  The address and other
details will appear.

For very common surnames (e.g. Smith), you will get a faster result by typing in the client's full name,
because there is every chance you will have more than one Smith in your records.  If you do just type in
"Smith", the program will locate all of your clients with that surname and present them in a list (Query
Result), like this:

5. Now just double click on the name you want, and the details will be displayed in
the correct places in the Client Details section.
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The same kind of thing applies if you only type in the first few letters of a name.  If the name is unusual
enough, the program will immediately locate the one person you are looking for, but if more than one client
in your database has a name that begins with the same few letters, the program will retrieve them all, like
this:

Sometimes this is useful, because you might want to locate a client, but don't know exactly how they spell
their name (for example, "Alison" or "Allison", "Lee" or "Leigh").  If you enter the whole name, it might be
the wrong spelling, and the program will tell you that no record exists for that person, so you have to try
again.  

By entering just a few letters (even just the initial), you will be sure to find their name in the Query Result
.  All you do then is to double click on the appropriate name, and their details will be copied into the correct
places in the Main window.

  NOTE: If you have enabled the Client Numbers function in Preferences, you
may also locate a client by that number. Simply type in the Client
Number field. However, you must type the exact number to get a
match.

10.2 Locating by Contract Number

You can locate a contract quickly by simply entering its contract number, if you know it.

To locate a contract by number:

1. Start with a blank screen, by clicking the Esc key. IMPORTANT: If you perform step 2
with a client located, you will start a new contract for that client rather than
locate an existing one.

2. Click the Items button on the tool bar (or use the Ctrl + I keys).

3. The cursor will jump immediately to the Contr field. Enter the number of the item you want
to locate.

  NOTE: If you have enabled the Auto Complete Contract Number option, you
can leave out the year and leading zeros in the number. E.g. If you are
trying to find contract 2015000198, you can just type 198 in the Contr
box to find it, if you have the option on.

4. When finished, click the OK button (or use the Ctrl + Enter keys).

If you do not know the client's name or the contract number, or if you want to locate something by any
other criteria, use the Search function.

10.3 Changing Client and Item Details

All client details can be changed at any time. However, once the details of a new contract have been
entered, you cannot change the amount (pledges), date, contract type (pledge, buy or consign), interest
rate or clerk details.
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To change any client or contract details:

1. Locate the client or contract.

2. Change any information you want to (bearing in mind the restrictions mentioned above for
contracts).

3. You will notice that as soon as any information is changed, the OK and Cancel buttons will
appear in the lower right part of the window.

4. Click the OK button to save the changes.

10.4 The Search Window

There will probably be times when you want to find things other than by their name or contract number. 
For example, you might be trying to locate a particular Samsung TV, but you can't remember the name of
the person who brought it in, or its contract number.  Or perhaps you want a list of all the Samsung
televisions that have come through your shop.

PawnShop has a Search function that can help you to find anything that is in your records in just a few
simple steps.  It may look a little daunting at first, but it is quite easy to use if you know how.  Take a look
at the following section and experiment with the Search function yourself – you'll soon find out that it's not
as complicated as it appears!

To start a search:

1. Click the Search button.     

2. This Search window will appear:
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2. Go to the Design Search Criteria section and click on the arrow at the end of the box
marked Field.

3. You will now see a list of all the different criteria you can search by: item names, contract
types, brands, names of clerks, dates of transactions, even clients' birthdays!  Scroll down
the list by clicking on the arrow and keeping the mouse button pressed down (or by using
the down arrow key) until you find the first thing you want to search by.

4. In our example, we are choosing "Item Name" – this list contains televisions. You will see
that the Operator box now contains the word "Equal".  This goes in automatically and it
simply means that you are going to choose from a list of all the different item names that are
already in the program.  

5. From the Value box, find the item you are searching for (we are looking for "TV"). In our
example, we are looking for a TV, so our search says "Item Name" "Equal" "TV".  If you were
looking for everything except televisions (unlikely, but possible!) you would modify your
search to say "Item Name" "Not Equal" "TV".

6. Now click the Add button (or use the Alt + A keys) – the details of your search are copied
into the lower part of the screen, the Current Query section. The screen should now look
like this:

7. If you were to run the query at this stage, you would get a list of every single TV in your
records, so you probably want to refine the search a little more.

Firstly, click the Reset button (or use the Alt + R keys) to clear the Design Search
Criteria fields. In the following example, we have chosen "Brand" as the second thing we
are looking for, and the Operator box says "Like" (this appears automatically, but you can
change it to "Equal" or "Not Equal", if you want).  "Like" means that you only have to type in
a few letters of the brand name, so we can just type "Sam" in the Value box (we are looking
for Samsung). This will find any TV with a brand name that contains the letters Sam, in
sequence. If there were a TV brand called Samson, this search would locate them as well! 
However, if you entered "Brand" "Like" "S", the program would retrieve records of all TVs
with a letter S anywhere in their names – not just Sony, Sanyo, Sharp and Samsung, but
Panasonic, Philips, etc.

8. Add more criteria, as before, in the Design Search Criteria section, clicking the Add button
after each one.

9. If you would like to put the list of results into some sort of order, you can do so by clicking
the Sort Order options. Ascending order means from the most recent to the earliest and
Descending order means from the earliest to the most recent.  Otherwise, the program
uses None.
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10. If you make a mistake, or decide to change the criteria you have chosen before hitting the
Add button, you can click the Reset button (or use the Alt + R keys) and the boxes will
clear.

11. If you want to change the criteria after you have hit the Add button, click the Delete button
and the information in the lower section will clear, line by line each time you click, starting
from the bottom.

12. When you are ready, click the Run Query button (or use the Alt + Q keys).  The program
will present you with a complete list of all the things in your records that fit your criteria.

In our example there are 2 Samsung TVs in the database.

13. If you find what you are looking for, double click on it, and the program will locate it in the
Main window along with all its other details.  Then simply close the Search window by
clicking the Close button (or using the Alt + C keys).

14. If you need to add more criteria to narrow the search down a bit more, click Search Criteria
(or use the Alt + S keys) to go back to your query.  It will not have cleared, so you can just
add to it.
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11 Payments
There are two instances where you would want to use the Payments window in PawnShop. The first is a
pawnbrokers who wants to make an interest payment for a pledge. Usually this will advance the due date of
the contract by 1 month (if a month's interest is paid) and may change the status of the contract if it has
passed its due date and the payment brings it back in pawn.

The other situation where the Payments window is used is when making a payment on a layby. See the
Sales and Auctions section for how to locate a layby.

Topics in this section:

Adding a Payment

Deleting a Payment

11.1 Adding a Payment

This section refers only to pawnbrokers. The text has been left black for readability.

To make an interest payment on a contract:

1. Double click on the relevant contract in the Contract List (or use the Ctrl + Y keys).

2. The Payments window will appear.

3. Select a Clerk with the mouse (or use the Alt + down arrow keys, then press the Enter
key).
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4. Click in the Amount field (or tab to it) and enter the payment amount.

  NOTE: You can enter any amount you want.  The amount does not need to be
an exact multiple of the monthly interest amount. However, the due
date will not advance until a month's interest has been paid.

5. If you want to make a final payment that is different from the balance owing – i.e. the client
redeems the item - you must click the Final Payment checkbox (or tab to it and then use
the space bar). The database then records that there is no money owing on this item.
Entering an amount identical to the balance owing will automatically tick this check box.

6. The date and time of the payment are automatically generated.

  NOTE: If you are entering a payment at a different time or date from that
displayed, you can manually change the time and date. 

7. Click OK (or use the F12 key) if the details are correct.  If you want to cancel the transaction
at this stage, click Cancel (or use the Esc key).

8. Click the Close button (or tab to it and then use the Enter key) to save the details of this
payment.

11.2 Deleting a Payment

In the Payment History list, you can see the details of past payments. You can delete any of these
payments as long as the contract has not been redeemed already (status is Out Pawn) and the record sent
to the police. Also, you cannot delete a payment for a layby that has been finalised.

  NOTE: If the contract has been redeemed and the record has not been sent to
the police, deleting a payment will bring the contract back into pawn.

To Delete a Payment:

1. Click on the appropriate payment in the Payment History list to select it.

2. Click the Delete Payment button.

3. Click Yes when asked if you are sure you want to delete the payment.
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12 Overdue Contracts
If you have selected the Send due items to shop automatically option in the Overdue Items / Sales
section of the Contract tab in Preferences, when an contract passes the regulatory time period that you
must hold it, it will automatically be given the status In Shop. If there is more than 1 item in the contract,
they will be split into separate contracts as detailed in the  Sending Items to Shop section.

If you have not selected the above option, when items fall due, their status in the contract list will be
displayed as Due Shop, Due Auction or Cons In Due, depending on the type of item and its value:

If you hold a second-hand dealer's licence, you can send these items to auction or to put them into your
shop for sale.  You also have the option to keep them as they are, if you like – rest assured, the program
will not send items in different directions automatically!  However, you cannot send items to shop or auction
until they have a Due status, and you must change this status to In Shop or In Auction before you can
sell them.

Topics in this section:

The Items Due window

Sending Items to Shop or Auction

Other Options for Overdue Items

Viewing Client Details in the Items Due window

12.1 The Items Due Window

At any time, you can bring up a list of all the items (of all types) in your shop which have fallen due, by
simply clicking the Items Due button on the tool bar.

The Items Due window will appear:
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The Items Due window lists:

· Overdue pledges, if no payment has been made after the time period you have specified.

· Purchased items, after they have been held for the time period you have specified.

· Consignments, after they have been held for the time period you have specified.

· Items that have been returned and have a status of Misc/Damaged. This allows you to assess
whether they can be fixed and sent to shop, or are irreparable and must be written off. You can
also send items to a status of Misc manually by using the Right Mouse Menu. See Using the
Right Mouse for more details.

12.2 Sending Items to Shop or Auction

To send items to shop or auction:

1. By clicking with your mouse on the black triangular arrow to the left of the item you want to
deal with, the whole line becomes highlighted, indicating that you are going to change the
status of the item.

  NOTE: You do not have to send an item that is Due Auction to auction, nor an
item that is Due Shop to your shop – it is your choice (although laws in
your area might require you to send to one or the other).

2. If you want to assess each item separately and decide where you would like to send it as you
go along, we recommend you highlight each item individually, then one of the options
marked Send to Shop or Send to Auction in the Item Options section on the right, then
click the Apply button.

3. If you have a lot of items to deal with and you are sure you would like to send them all to
your shop, for example, you can highlight all the items in the list which have the same status
by pressing the Ctrl key on the keyboard at the same time as you are clicking on the black
arrows (it will look a bit like the picture below).

4. When you have highlighted all the items (with the same status) you want to, click the Apply
button and status of all of the items will change at once. This will obviously save you lots of
time!  

  NOTE: If you highlight any items from contracts which contain more than 1
item, you will be splitting that contract into separate contracts which
each have 1 item from the original contract. E.g. If contract
2006000010 has 3 items in it and you send one of them to shop, the
original contract will first be split into 3. The numbers of these split
contracts will be the same as the original one with a /1, /2 or /3 at the
end to identify which item they contain from the original. The program
needs to do this so you can sell items in the contracts separately.

5. Continue highlighting items and sending them to shop or auction until you are satisfied that
there are no more on your list you want to deal with.  Sending items to shop or auction this
way ensures that you have control over each one – you cannot make a mistake by
inadvertently clicking the Apply button.

6. Click Pipe to Main Screen to close the Items Due window and return to the main window,
if you want a complete list of all the items you have just dealt with to be displayed.  You can
then allocate a shop number and price for each item in the list, as below (notice these fields
in the Sale Details section):
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or:

6. Click Back to Main Screen if you just want to return to the main window to do something
else (e.g. enter details of a new pledge, if a client comes in).

You are now ready to sell these items in your shop or at auction.

  NOTE: Payments can still be made on items that have a status of "In Shop" or
"In Auction". In fact, if a client pays enough money on an item to make
it current again (not overdue) the program will recalculate its status
and remove it from the Items Due window.

12.3 Other Options for Overdue Items

In the top right-hand corner of the Items Due window, you can see this box.  If you have any items which
are overdue but which you do not want to send to shop or auction, you can choose from a number of other
options.  As you can see, it is possible to select each of these options by using one of the F keys as an
alternative to clicking inside the appropriate circle.
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As well as the options we have already mentioned (Auto Split Item, Send To Shop and Send To
Auction), the following options are available:

· Send To Damaged - this means the item is written off and has been removed from your shop.

· Send To Misc – this means that the item can't be sold – for example, it is being repaired, but
remains in the Items Due list for future disposal. 

· Return To Owner – this means an item is to be returned if it proves to have been stolen. You
will receive a confirmation box if you choose this option.

· Manual Split Item – this is used to split a contract where there was only one item in the
contract, but that item can be split and sold in separate parts. For example, you can use this if
you want to sell individual tools within a toolbox that was pledged as a single item.  See the
Manual Split , if you need to know how to do this.

· Other Disposal – for any other disposal of an item, for example, a gift.  If you choose this
option, you are required to type in what kind of disposal it is, in the box provided.
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12.4 Viewing Client Details in the Items Due window

You may like to know that when you are in the Items Due window, you can bring up all the details of any
client whose items are overdue, without having to go back to the main window. All you have to do is right
mouse click on a particular item in the list, and the client details will appear.
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13 Sales and Auctions

Topics in this section:

Adding a New Sale

Sale Returns

Laybys

Making a Layby Payment

Overdue Laybys

Cancelling Laybys

13.1 Adding a New Sale

To make a new sale:

1. Either click the Sales button with a clear screen on the Main window

or

Locate an item which has a status of In Shop or In Auction on the Main window and then
click the Sales button.

2. Select a Clerk.

3. Either type in the contract number or check that it is correct in the Contract # field.

4. Click the button on the right 
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· If you have only entered the contract number, the button will say Locate. When you
click it, the description and price will appear, and the button name will change to Add
. Check that the details are the ones you require, then click it again.

· If the item description is already there (because you located the item before entering
the Sales window), the button will already say Add (as in the picture below) and you
only have to click it once. 

5. The details of the item are copied into the Transaction Details section.  If you want to sell
other items at the same time, go back and locate/add them in the same way.  When you
have finished entering the list of the items to be sold, just click Sale or use the F5 key to
process the sale.

6. As soon as you click Sale, the following part of the screen is activated, and the date and
time of sale are automatically generated. There is also provision for you to enter you own
receipt number in the Man Rec box in case you have your own set of numbers that you use.
You can locate a sale by the number you enter in this box as well as by the one automatically
generated by the program. The program will assign a Rec # once you click the OK button in
the Sales window.

7. If the sale is more than the prescribed amount in your Preferences, you are required to
enter the details of the client who is buying the item from you in the Buyer's Details
section.  If this person is one of your existing clients, their details will already be in your
database, so you just need to type in their name and then click Locate – the program will
then put in all their details from your records. As in the Main window, if the client does not
exist, you will be prompted to add them. However, all you need to add for buyers are the
name and address.
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8. Click OK when all relevant details have been entered and you are ready to print

9. If you forget to enter a client's details for an amount over the allowed limit (set in
Preferences), the following message appears on the screen to remind you:

10. Click the Print button to print the sales receipt.

11. Click Back to Main Screen when you have finished.

13.2 Sale Returns

To record the return of Sold or Auctioned items:

1. With a clear screen (press the Esc key to clear all details), click the Sales button.

2. Enter the receipt number in the Rec # field. Click the Locate button.

3. The sale details will appear in the Transaction Details section.

If you do not know the receipt number, you can still locate the sale:

1. Locate the client who bought the goods from you by name, as you would a normal client.

2. Go to the Options menu and select Find Sales (this option is only present in the menu for
those clients who have sales)
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4. A box containing the receipt number, date of sale and item description will appear. Just click
on the sale you are looking for and click the Select button.

5. The Sales window will then display with your sale loaded. By clicking with your mouse on
the black triangular arrow to the left of the item you want to deal with, the whole line
becomes highlighted, indicating that you are going to return that item.

6. Click the Return (F7) button.

7. Click the OK button.

13.3 Laybys

A layby is almost identical to a sale, except that it is paid off in instalments rather than all at once.  The
dealer holds the goods until they are completely paid off.  There are certain retail laws governing laybys (for
example, a customer has the right to cancel a layby at any time), but you determine how long to hold the
goods, how many payments will be made, and what the amount should be.

The procedure for putting an item on layby is the same as for making a sale, up to the point where you
locate the goods and add them to the Transaction Details – after this, you click the Layby button (or use
the F9 key), instead of the Sale button.  

Next, move on to the payment field and select the payment type, and when you have done so, the Layby
Details section will appear:

In the example above, the total amount of the goods will be $40, and the number in the Deposit field (in
this case $8.00), is 20% of the total price.  The number representing the 20% calculation appears
automatically, but you can change it if you want.  
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After this deposit has been paid, you simply click OK to process the transaction and then the Print button
to print out the receipt (unless you have opted to print these receipts automatically).

13.4 Making a Layby Payment

To make a locate a layby:

There are 2 ways to locate a layby in order to make a payment on it.  The most common is:

1. With a clear screen (press the Esc key to clear all details), click the Sales button.

2. Enter the receipt number in the Rec # field. Click the Locate button.

3. The layby details will appear in the Transaction Details section.

If you do not know the receipt number, you can still locate the layby:

1. On the Main window, locate the buyer as you would a normal client who you buy or pledge
from.

2. Go to the Options menu and select Find Laybys for (this option is only present in the menu
for those clients who have laybys)

  NOTE: The Find Laybys menu item will only appear in the Options menu if the

current client actually has a layby attached to them.

To make a payment on a layby:

1. In the Sales window, click the Payments button in the Layby Details section.
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2. The Payments window will appear.

7. Click the New Payment button at the bottom (or use the F6 key)

8. Enter the payment information in the usual way. (Non-pawnbrokers may need to see the 
Payments section to find out how to enter a payment).

  NOTE: You can check the balance owing on a layby at any time by clicking the
Payments button in the Layby Details section of the Sales window,
without having to make a new payment.

13.5 Overdue Laybys

PawnShop has a feature to remind you if you have any overdue laybys, so you can contact the clients if you
want to. This feature can be turned on and off by an option in the Preferences window. The General
group under the General tab on the Preferences window looks like this:

If wish to use the reminder, you must place a tick beside the Overdue Layby Reminder option. This
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option is turned off by default, so you must turn it on to start it working. After you have saved the changes
in the Preferences window, a message will appear, each time you start the program up, as below:

By going to the Options menu and selecting Overdue Laybys, you will be presented with a list of any that
are due:

By clicking the Select button for an entry in this list, you will be taken to the Sales window to see the
details of the layby, including the client's name and address. From there you can cancel the layby if you
wish. See the Cancelling Laybys section  for more details.

13.6 Cancelling Laybys

You can cancel a layby that may be overdue or if the customer simply wants their money back.

To cancel a layby:

1. Locate the layby as described in the Making a Layby Payment section.

2. The Cancel button will be visible where the Sale, Auction and Layby buttons normally are.
Press the Cancel button. Click Yes when asked if you're sure you want to cancel the layby.

3. The Cancel Layby Details window will appear
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4. If you normally charge a fee for laybys, click the Yes, I want … option and enter the
amount you are charging in the box next to it. If you are returning all their money, leave the
option on No, I just want to cancel the layby.

5. Choose your Clerk and press OK. The items in the layby will be returned to a status of In
Shop so that you can sell them again. Pressing Cancel will close the window without
changing the layby.
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14 Reports
PawnShop allows you to produce a series of up-to-date reports on your business, helping you to monitor the
financial situation of your business at any point in time, or for any period of time. These include detailed
reports of goods held, income and outgoings, and auction reports as well as some reports mandated by the
NSW police.

You can print these reports out, save them in files on the computer for later use (which can be helpful if you
want to keep a series of them), or simply look at them on the screen.

PawnShop will save reports in the popular Adobe Acrobat (PDF) format. You can obtain a viewer for these
files from your installation CD or the Adobe web site.

Goods Held Report

This will display a list of items currently held on your premises. This includes all items that are in your
possession (including items in shop or in auction, but excluding items sold or auctioned).

Income Report

This report lists all types of income recorded by the program at any given time. This includes pledge
payments, layby payments, shop sales and auction sales.

Outgoings Report

This report lists outgoings recorded by the program at any given time. This includes all pledge loans,
purchases, refunds and returns.

  NOTE: You can also monitor income and outgoings totals in the Cash Drawer
window. 

Auction List Report

This report lists all items that have the status In Auct, and are therefore ready to be sent to auction for sale.
This includes all pledge loans, purchases, refunds, returns and write-offs.

The Internal Report option is designed to produce a report that lists all relevant auction information, so it is
intended for private use only and NOT for distribution to the public (as it contains private pawnbroker
information).  It includes all information such as auction lot number, auction type, contract number, item
description, amount lent, and due date.

  NOTE: This report is useful to keep track of all items that have been sent to
auction. It can be used as a guide for entering auction sale amounts
after auction.

The External Report option is designed for pawnbrokers who will coordinate their own auctions, and want to
produce a list of auction items that can be distributed to the public, so it only includes information such as
auction lot number and description.

Auction Type

As some laws specify that different auctions must be held for jewellery and general items, this section allows
you to specify which auction type (or both) report you produce.

Damaged Goods

This report lists all contracts marked as Damaged or Return to Owner in the Items Due window.

Item Storage Location

This report lists the location (as entered in the Notes window) of any items not located on your premises for
contracts taken in between the dates you specify.

Customer Sold To

This report lists all buyers of all contracts between the dates you specify.
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14.1 Running a Report

To run a report:

1. Click the Reports button on the tool bar.    

2. The Reports window will appear.

3. Select the report from the Report Type section (click inside the circle).

4. Select the format you want (Detailed with Totals or Totals Only) from the Listings
section. 

  NOTE: After selecting the Auction List report, you can specify whether you
want an internal or an external report. An internal report lists extra
things like cost price, which you obviously wouldn't want people at the
auction to see.

5. The Time section is set according to the type of report you choose.  For Goods Held and
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Auction List reports, you have the Current time setting, which covers everything that is
current in your database. For other reports you have the Period time setting – here you
select a time period (type in the From and To dates) for the report to cover. 

6. For auction reports, select the Auction Type (Jewellery, General or both).

7. Click the Run Report button to create the report. 

8. The Report Result window will appear. Depending on the type and time period of the
report, this can take a moment or two.

14.2 The Report Result window

After running a report, you will be presented with the Report Result window. The actual layout of each
report will differ, but there are common elements at the top of each screen. We have shown a Goods Held
report in the example below.

The buttons at the top of the screen allow you to print the report out or save it for later use.  You can also
zoom in or out to be able to see more details, and move forwards or backwards by using the page control.

When you click the Print button, you will be prompted to change the paper in your printer (as long as you
have set this in Printing Preferences).  This will avoid using receipt paper by mistake!

When you click the Export to PDF button, a window will pop up.  In this, you specify a directory and file
name for the report.  Pick a name that describes the report, allowing you to easily find it the next time you
want to see it.  Each report file you save will automatically have the file extension .pdf at the end of the
name you type in.

14.3 Viewing a Saved Report

After you have saved a report, you can go back and look at it later, which is useful if you want to compare
different reports over a period of time.

  For example: If you create and save an income report (totals only) after business
every Saturday afternoon, you can easily compare previously saved
reports, and monitor changes in your income.

You can view a saved report by locating it with Windows Explorer and double clicking on it. You need to
have Adobe Acrobat Reader to see the file, which is available from the Adobe website.
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15 Receipts
The accurate printing of receipts is essential to the running of a pawnbroking or second-hand dealer's
business. This is because computerised receipt printing:

· allows you to eliminate time-consuming hand-written paperwork 

· gives you clearer and more concise receipts

· can create multiple copies of the same receipt

· provides an easy and concise way to provide your documentation to local police

PawnShop allows you to print receipts for:

· New pledges, buys, and laybys

· Payments on pledges (including pledge redeems) and laybys 

· Shop and auction sales

The program can either print your receipts automatically, or you can choose to print them by clicking a
button from most windows of the program.

PawnShop also gives you a choice of layout for your printed receipts (see Receipt Preferences). This is
useful, as you can make sure that the program prints around your own receipt design with all its pre-printed
details (such as logos, addresses, and legal information).

15.1 Automatic Printing

If you want, you can get the program to print receipts out automatically for each transaction, as you work.
This includes receipts for new contracts (pledges, buys or consignments), new laybys, pledge payments,
layby payments and shop sales.  To do this, you have to set it up in the Preferences section.

1. Go to the Options menu

2. Select Preferences

3. Click on the Printing Preferences tab

4. In the Receipt Options section, click inside the relevant checkboxes if you want the receipts
to be printed automatically.

After activating these Auto Print options:

For new pledge/buy/consignment receipts, printing will begin when you click the OK button after you have
entered the item details.

For sales/layby receipts, printing will begin after you click the OK button in the Sales window.

For pledge/layby payments, printing will begin when you click the OK button after entering the payment
details in the Payments window.

15.2 The Print Button

Even if automatic printing is not set, you can still print a receipt whenever you want by simply clicking the 
Print button, which appears on any window where printing is available.

  NOTE: The Print button will appear regardless of whether automatic printing is
selected. This allows you to print multiple copies of the same receipt.
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15.3 Receipt Reprints

PawnShop allows you to re-print pledge, purchase and consignment receipts at any time. This is useful for
instances where a client loses the original receipt, or in the case of a dispute where the details of the
original transaction are called into question. You can re-print the original receipt of any item as long as it
has not been sold or auctioned. This includes all pawns (including those that are Due Shop/Auction or In
Shop/Auction), and all laybys.

  NOTE: Contracts that are split into different items cannot have their original
pledge receipts reprinted.

To avoid having a permanent Print button visible in the Main window (which could lead to accidental

reprints), a special procedure must be followed to make the Print button appear.

  NOTE: Flyware recommends that you do not make any changes to the contents
of the description, as the description in the program’s database should
always be identical to that on any printed receipt – for later police
reference.

To reprint a receipt:

1. Locate the record of the item to be reprinted.

2. Double click on the item in the Contract Item Details section (or use the Ctrl key + the
number of the item in the Contract Item Details section). 

3. The Item Details window appears – click Cancel.

4. Click OK in the main window. The Print button will appear.

5. Click the Print button.

15.4 Reprinting Past Payments

It is possible to print another receipt of a past payment made on a pawn at any time (even when the status
of the item is Out Pawn, Sold or Auct). This is useful in the event of a dispute over the number of payments
made on an item while it was in your possession.

To reprint the receipt of a past payment:

1. Locate the record of the item to be reprinted.

2. Double click the item in the Contract List. This will display the Payment window.

3. The Payment History field is located on the left-hand side of the
payment window. This contains a history of all payments made on this item.

4. Select the payment you want to reprint and click on it once.
The Print button will automatically appear.

5. Click the Print button to reprint the receipt of this payment.

15.5 Customised Receipts

Although there are three formats of receipts that come with PawnShop, you may want to change certain
features of the printing.

You can customise the look of your receipts yourself. You should look at the document titled 'Custom
Receipt Formats.doc' which was placed in your program directory when you installed the program for
further information.
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16 Other Features
There are more advanced features of PawnShop which might not be required by all people who use the
program. This section describes some of those features in detail. As you grow in confidence in using the
program, some of these features may become of interest to you.

Topics in this section:

Using a Program Password

Using a Password with Reports, Cash Drawer and Deleting Clients and Items

Client and Item Notes

The Cash Drawer window

The Calculator window

Using the Right Mouse Button

16.1 Using a Program Password

To protect your information, you may like to put a password on the program, which will prevent any
unauthorised person from being able to use it.  The procedure for doing this is very easy, and each time you
start the program, this window will appear:

Access to PawnShop will not be granted until the password is entered.

To initially set up a password:

1. From the Options menu, select Preferences

2. In the General Preferences tab, click inside the checkbox marked Activate Password.

3. Click OK to close the window.

4. When you next start the program, the screen shown above will be displayed.

5. Type password into the field marked Password.

To change your password:

1. Go back to the Options menu and select Change Password…



83 PawnShop Documentation

© 2015 Flyware Pty Ltd

2. The following window will appear:

3. Type in your chosen password twice, once in each field.

4. Click OK.

16.2 Using a Password with Reports, Cash Drawer and Deleting
Clients and Items

You have the ability to put a password on your reports and/or your Cash Drawer screen.  This is of benefit
to any shop owner who prefers not to let employees have access to their financial details.

  NOTE: The password is separate from the one for opening the program.

For password security on Reports and/or the Cash Drawer, go to the Options menu and select
Preferences. Click on the Printing and Security tab and you will see the Security Options section on
the right-hand side:
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You can tick any of the boxes to have the program request a password before allowing access.

To put password security on Reports, Cash Drawer or Deletes:

1. Click in the box(es) in the Security Options section of the Printing and Security tab, as
described above.

2. Click the Change Password… button.

3. The following will appear:

4. If you have not used this feature before, type password in the first empty field, otherwise
type the password you changed it to previously, and then click OK. A new box will appear:

5. Type your new password in the first empty field, then again in the second to confirm it.  

  NOTE: It is advisable to use a password that cannot easily be guessed!  

6. Click OK.  The program will now only accept the password you have just entered.  Anyone
who tries to change the password will have to know what it is in order to change it!

16.3 Client and Item Notes

Although you can record a lot of information about clients and items in the main window, there may be
times when you would like to make a note of something extra. For example, if a client phones to say they
will come in on a certain day to redeem or make a payment on a particular item.  In this case, you just click
a button.
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In the Status Bar at the bottom of the screen you can see these 2 buttons:

Simply click the appropriate button (or use the F6 or F5 keys) and a small window will appear, allowing you
to type in your extra details.  You also have the option to print them, if you want.

When you have finished, simply close the window by clicking OK.  In our example, we made notes on an
item, and the words Item Notes now appear in red in the status bar, giving you a clear reminder whenever
that item is located.

16.4 The Cash Drawer window

The Cash Drawer window allows you to keep track of the amount of money that is in your register. It
provides an excellent tool to schedule trips to the bank (to keep cash stored on shop premises to a
minimum) or even to monitor possible cash thefts by staff members.

To access your Cash Drawer:

1. Go to the File menu and select the Cash Drawer... option.
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The Reset button lets you reset the balance of the Cash Drawer window to match the actual balance in
your register. Thus, you can specify an amount for a "float" at the beginning of each day. The Date field
shows the date and time that you reset this amount. 

The Income and Outgoings fields record all income and outgoings totals from the time you hit the Reset
button. Income includes all interest and layby payments as well as all shop and auction sales. Outgoings
include all pledge totals and purchases, as well as shop refunds or returns.

The Balance represents the amount you have in your register.  In our example above, you can see that we
have taken into account the $25 float; otherwise the balance would only be $210!

  NOTE: More detailed information about your income and outgoings can be
viewed by using the Income and Outgoings reports in the Reports
window. These reports can display total amounts as well as detailed
lists of each transaction. 

16.5 The Calculator window

To open your system calculator:

1. Go to the Options menu and select Calculator with your mouse (or by using the Alt + C
keys).
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  NOTE: The calculator function will only work if your system calculator file is
named calc.exe. If it is not, you can simply copy it to calc.exe. This file
can be found in your Windows folder (usually C:\Windows). Make sure
you are comfortable copying files before you attempt this.

16.6 Using the Right Mouse Button

Whenever there is a reference in this manual to "clicking the mouse", it almost always means the left mouse
button.  However, Flyware has incorporated some functions into the right mouse button and all references
to these are clearly specified as right-mouse button clicking.  Using the right mouse button often gives you
a quick and easy way to do something, so it is definitely worth looking at.

a) For items which are In Pawn or In Shop – if you right mouse click on any item in the
Contract List section, the following appears:

This enables you to either delete a contract, put it on police hold, return to the owner (the
original owner meaning that this item was stolen!) or send the item to a miscellaneous state
(for example, being repaired).  Simply select the option you want by clicking on it with the
left mouse button.

b) For items which have been redeemed (their status reads Out Pawn), right mouse clicking
will produce the following:

Again, you can delete the item from your database, or you can copy all the details of this
previous pledge as a new item (see Copy for New for how and when to use this).

c) For items with a status of Sold, Auctioned or Layby, right mouse clicking will produce the
following:
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Again, you can delete the item, or you can find the details of the person or organisation that
bought the item.

d) For consignments, right mouse clicking will produce the following:

As before, you can delete the item, put it on hold, you can cancel the consignment if the
owner of the item decides to take it back before you sell it or mark the item as stolen or send
to miscellaneous.
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17 Miscellaneous Functions
This section contains some of the other useful functions that can be found in PawnShop.  If you are trying to
find the solution to a problem that doesn't seem to be anywhere else in the manual, the chances are that
you will find it here.

Topics in this section:

Changing Column Widths

Changing a Contract Number

Duplicate Contract Numbers

Deleting a Contract Record

Deleting a Client Record

Police Offload

Police Resupply

Resupplying Individual Contracts

Police Printout

Viewing a Police File

Checking for Police File Errors

Changing the Client That a Contract Belongs To

Manually Splitting a Contract

Redeeming Goods After Putting Them In Your Shop

Updating Your Version of PawnShop

17.1 Changing Column Widths

The columns in each table are set at certain widths, but you can make them wider or narrower at any time.

1. Place your mouse cursor at the top of the column you want to widen, where the dividing line
is. The mouse cursor will change from an arrow to a vertical bar with horizontal arrows on
each side.

2. Hold the left mouse button down and then move the cursor to the right or left as far as you
want.  You'll see the column change width.

3. When you're happy with the new width of the column, release the left mouse button.

  NOTE: If you lose control changing these column widths, you may find that
you 'lose' a column. This means that the table isn't wide enough to
accommodate the column widths you have set. (Clicking on any listing
in the table and then using the right or left keyboard arrows to pan
right or left will reveal these lost columns). If this happens, you must
use the procedure outlined above to re-size all the column widths.

The column widths are saved every time you close PawnShop.

17.2 Changing a Contract Number

Although you should rarely need to, PawnShop makes it possible for you to change a contract number.  
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1. Locate the contract in the Contract List.

2. Go to the Edit menu and select Change Item No…

3. The following window will appear, with the original contract number highlighted.  Simply type
in your new contract number.

4. Click OK and the contract number will change immediately in the Contract List.

17.3 Duplicate Contract Numbers

In very rare cases, you may (accidentally or intentionally) create a duplicate contract number.  In order for
this to happen, you have used Manual numbering, and you have changed a contract number to one that
will be used in the future.  If this happens, when you try to use the same number again, a warning like this
will appear on the screen:

17.4 Deleting a Contract Record

To delete a contract record:

1. First, locate the contract in the Contract List. It should be highlighted if there are more than
one in the list.

2. Do one one the following:

a) Use the Ctrl + D keys

b) Right mouse click and choose Delete
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c) Go to the File menu, choose Delete and then Item

3. In each case, you will then be asked if you are sure you want to delete the contract.
Depending upon your security settings in Preferences, you may also be asked for a
password.

17.5 Deleting a Client Record

To delete a client record from the database:

1. Locate the client you want to delete.

2. Go to the File menu, choose Delete and then Client.

3. You will be asked if you are sure that you want to delete the client. Click the Yes or No
button.

Warning: All contracts and sales related to the client will also be deleted.

17.6 Police Offload

At the time of writing, all pawnbrokers and second-hand dealers in NSW are required to provide the police
with information about their business via the Internet.  You are required to send a text file in the police
specific format by using the police website. PawnShop has been designed to match the police format and
makes this as easy as possible for you. Simply click the Police button (or go to the File menu and select
Police Offload).

Once finished, you can log on to the Police web site to transfer your file. This process takes just a few
moments and gives the police up-to-date information about your transactions since your last transfer. You
can change the location of the police file by changing the setting in Preferences. By default, it is set to
C:\Pawndata.txt.
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17.7 Police Resupply

Occasionally, the police may ask you for backdated information or for information spanning a certain period
of time.  For this, you insert the floppy disk as before, then go to the File menu and select Police
Resupply…

The following window will appear:

Simply type in the dates the police require, then click OK. A file will be created in the same place as your
normal police offload file with contracts falling within the dates included.

  NOTE: This does not affect contracts in your normal police load. You can run a
police offload after a resupply and all the correct contracts will still go
in the offload.

17.8 Resupplying Individual Contracts

Sometimes the police only require that you resend a particular contract after you have fixed some problem,
like a missing date of birth, for example. In this case, they do not require a full resupply of all contracts,
just the one that you have amended.

To add a single contract to your next police offload:

1. Locate the contract to be re-sent to the police. Make sure it is highlighted in the Contract
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List.

2. Click on the Mark Contract for Offload menu item in the Edit menu.

3. The contract will be included in your next police offload. Note that for split contracts, only the
split item will go to the police. If you need to send an entire contract that has been split,
you'll need to highlight each item and click the Mark Contract for Offload menu in turn.

Note that if you DON'T want a contract to go to the police (you may have fixed on that has been
successfully sent), you can use the Remove Contract from Offload menu item to stop it being transferred
in the file.

17.9 Police Printout

It is also possible to print out information for the police.  To do this, select Police Printout… from the File
menu and a similar window to the one above will appear.

As before, type in the dates, and you will get a printout of information about all the pledges and purchases
you have handled between the specified dates.

17.10 Viewing a Police File

Sometimes it is advisable to quickly check that the data file you are giving to the police has the information
they require.  If you are at all unsure whether you have copied the data to give to the police, go to the Edit
menu and select View Police Offload… (if you have your police file set to go to the floppy drive, make
sure there is a floppy disk in the drive first).
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If the screen immediately fills with information, as below, the data has been copied to the floppy correctly.  

17.11 Checking for Police File Errors

Sometimes when you send a file to the police, they may reject your data for a number of reasons. Some
data may be missing which the police specify must be present. To help you to catch these errors before
actually sending the file, there is a Problem Report function built into the program.

The report only works on data that will be sent in your next transfer. It won't scan your entire database for
errors.

To run the Police Problem Report:

1. Select Police Problem Report… from the File menu on the Main window.

2. If you have any errors that have been recognised, a new window will open. Each error will
appear on a separate line with the client name or contract number.
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3. You can double click on an error to load that client/contract in the Main window, and then fix
the problem. Click Refresh to do the check again when you have fixed the error.

  NOTE: This function does not claim to fix all possible errors that the police
may find, but it will help you eliminate the most common ones before
sending your data to them.

  NOTE: This function now runs automatically when you run a Police Offload if
you are a NSW user.

17.12 Changing the Client That a Contract Belongs To

Sometimes if you are rushed in your shop, you may not locate a client correctly and end up entering a new
one when they are already on the database.  A more common mistake is to assign items to an organisation
or client that the police will not allow.

In these cases, you may need to alter which client is linked to a particular item.  Say for example that you
have entered George Smith in your database twice and have attached one item to one and want to move it
to the record with all his other items.

Note that what we are talking about here is moving items to an existing client. If you just want to change
the name of the client you don't have to move items to another client, just change the details directly.

To move all contracts for a particular client to another:

1. Locate the client that you want the items moved from.

2. Then click the Move Items to New Client menu item under the Edit menu.

3. You'll see a warning like the one shown below. Click Yes if you are sure you want to do this.

4. The program will then clear the screen and prompt you to locate the client you want the
contracts moved to.

5. When you click OK to locate the client, the program asks you to confirm that the client you
have located is indeed the one you want to move the contracts to. If you click Yes, all
contracts from the original client will be added to the client you have just located.
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17.13 Manually Splitting a Contract

Occasionally you may find that you need to split up individual items that were originally pawned together,
and make them into separate contracts – for example, you might have a toolbox containing a saw, a
hammer, a drill and a set of screwdrivers, which were all pawned together and not redeemed.  You may
then want to sell the drill (or any of the other items) separately.  

To manually split a contract:

1. Bring up the Items Due screen and locate the contract you want to deal with.

2. Click on the arrow on the left to highlight the line.

3. Click inside the option next to Manual Split Item (on the right of the screen), then click
the Apply button.  The In Items Details window will appear.

  NOTE: In the example above, the total amount for the toolbox and the tools
inside was $75, so when we split this contract up, we will have to
allocate prices to each of the items to total $75.  But don't worry - the
program helps you to keep track (or change your mind!) as you go
along.

4. Now you need to delete the original Description and Item Amount and put in just one of
the items and the new amount you allocate to it.  In our example, we will allocate the two
spanners as one item and price them at $10.  After you click Next you can see that the
Total Amount is also $10 - this will change as you add more items and their amounts to the
contract.
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5. Click the Next button and put in the next item, its amount and any other details. Keep doing
this until each item has been entered separately and the Total Amount is the same as the
original amount for the contract.

6. Click OK.

At any time during this procedure, you can change the amounts by using the Next and Prev buttons.
Whenever you change an Item Amount, the Total Amount will also be recalculated.

The Reset button deletes the last item you entered.

The Cancel button cancels the whole contract – you will get a message asking you if you are sure you want
to cancel it.  This prevents you wiping out your work accidentally!

The Repeating… button can be used for splitting up a number of items all of the same type and the same
value – for example, 5 CDs which were pawned together but which are to be sold separately (note that NSW
police regulations require you to enter every CD separately).

If you use this option, clear the Description and Amount fields before clicking the Repeating… button.  A
window appears in which you type in the number of items and the total amount for all of them, and the
program calculates the amount for each separate item.
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17.14 Redeeming Goods After Putting Them In Your Shop

A client may still redeem their goods from you, even after these items have fallen overdue and been placed
in the shop for sale, as long as they are prepared to redeem all items pledged in the original contract.  If
the contract contained 2 or more items, these will have been split up in order to sell them, and now cannot
be redeemed individually.  As with any contract in which items are pledged together, the interest is
calculated on the entire contract, and clients cannot make payments on single items within that contract, or
redeem them separately.

If the client still wishes to redeem all their original items, you first have to "unsplit" them, which means
putting them back together in one contract.  To do this, simply right mouse click on each item in the 
Contract List, and select Unsplit from the menu. 

As long none of the items in the contract have been sold, auctioned or otherwise disposed of, the contract
will go back to its original state and you can make a payment on it as normal.

  NOTE: Once any of the items in the contract have been disposed of, you cannot
unsplit the contract and cannot make any payments on it. You can
simulate a redeem by selling the item in question for the same price as
the redeem would be.

17.15 Updating Your Version of PawnShop

PawnShop comes with the ability to download updates from the Internet. You MUST be connected to the
Internet to perform this function.

1. Click the Help menu on the PawnShop screen.

2. Click the Check for Updates.. menu item.

The program will then download a small text file from the internet which contains the current version of
PawnShop. This is compared to your version to see if your system needs updating. If it does, you will get a
message saying that a new version has been found and asking you if you want to download the patch for it.

After the download, PawnShop is closed and the patch is started. As usual, you should perform a backup
before starting this procedure to protect your data.

Alternatively, you may download patches manually from the Downloads section of our website. Note that
you must exit PawnShop before applying any patch.
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18 Database Maintenance
Topics in this section:

Backups and Restores

Backing Up a Database

Restoring a Database

The Repair Database Option

The Test Backup Option

Automatic Backups

Updating Suburbs, States and Postcodes

Setting up PawnShop to run over a Network

Export Clients and Contracts

18.1 Backups and Restores

If you think about the amount of information you are storing every day, and imagine that, for some reason,
something were to happen to your computer, you'll realise what an important precaution backing up is.  You
should perform backups regularly to avoid losing your data – we suggest a few times (or at least once)
every day.  You can do this onto a floppy disk or to another place on the hard drive, if you prefer.  We
recommend using a floppy disk or USB key, in case your hard drive is ever damaged. 

The procedure for backing up is very simple and can be done in just a minute or two.  It is definitely a habit
worth getting into and could save you a lot of heartache!

18.2 Backing Up a Database

If you have specified that you always want your database backed up to the same place, you will have
selected the Always Use option when you set up your preferences (see General Preferences section to
check):

1. Insert a disk into the floppy drive if this is the place you prefer to save your data.

2. Either:  Choose BackUp Database from the File menu
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Or:  Use the Ctrl + B keys.

3. All your data will be backed up to the place you have specified.
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If you prefer to back up your data to different locations each time, you will have selected the Ask option in
General Preferences.  This simply means that when you complete Step 2 above, a box like this will appear
on your screen:

You can then specify the place where you would like to save your data (naturally, your box may not be
exactly the same as the one above – it will show your own folders and files).  In the text box File name,
type in the name you would like to call this backup file, then click Save.

  NOTE: Try to use a meaningful name when backing files up.  For example, use
the month and year in the name, which should make it easier to keep
track, especially once you start to save quite a few.

18.3 Restoring a Database

As with backups, the procedure for restoring your data differs slightly, depending on whether you have
chosen to always back up to the same place or not.  If your backups are always in the same place you will
have specified the Always Use option in  General Preferences, and the procedure for restoring is as
straightforward as for backing up:

1. Insert the disk with your last backup file into the floppy drive (if applicable).

2. Choose Restore Database from the File menu.
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As before, if your backups are saved in different places each time, you will have selected the Ask option in
General Preferences, and when you choose Restore Database from the File menu, a window will appear
and you can type in the file name and click the Open button.

Warning! When you restore a database, you will overwrite the one
currently in use. Make sure that the file you are restoring is the one
you want.

18.4 The Repair Database Option

The Repair Database option can be selected if you encounter any problems with the database.  It will
force PawnShop to go through the checking procedure it performs during its first start-up every day
(checking for errors in records, missing records and automatically compressing the database).  To use this
option, simply select Repair Database from the Options menu.
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18.5 The Test Backup Option

The Test Backup option can be selected to test that a backup you have created is not corrupt. You should
do this as often as you can to make sure that if you need it, your backup will restore properly. Magnetic and
electrical fields can affect floppy disks and damage the data on them. Use this function under the File menu
to check that your backup is OK.

18.6 Automatic Backups

There is an option in Other Preferences, which allows you to schedule automatic backups to be made during
the day while you work. These backups are saved to your hard disk and are useful for returning to the
database before a corruption occurred or before some data was entered by mistake.

They are not a substitute for doing normal backups to a removable disk because if your computer is stolen
or your hard drive crashes, you will lose all your information.

18.7 Updating Suburbs, States and Postcodes

It is possible to make changes to the list of suburbs, states and postcodes provided with the program, or to
delete the existing list altogether and enter your own.  This is useful for those outside New South Wales or
even overseas.  It will also appeal to users who want to limit the number of suburbs to those in their
immediate vicinity, with the option of adding new ones when they arise.  In this way, everyone can
customise the list for themselves.

  NOTE: NSW users MUST leave the postcode list imported into the program as
is. Updates from Flyware will provide the latest file from Australia Post.

To update your suburb, state and postcode list:

1. Go to the Options menu and select Preferences.  In the General Preferences tab you
will see the Suburbs and Postcodes section.

2. If you click on the button on the left, the following window appears:

3. As with other windows in the program, you can select a particular entry in the list by clicking
on the arrow on the left. To highlight an entire range, hold down the Shift button as you
click the top and the bottom entries and everything in between will be selected as well.  

4. To highlight several entries, hold down the Control button and click the individual suburb
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names you want to get rid of.  For example, if you live in the Perth metro area, you might
want to remove the country postcodes from your list, so you may go down the list this way:

5. Once you have highlighted the suburbs and postcodes you want to remove from your list,
simply press the Delete button on the keyboard.  If, in the future, you want to add a suburb
and postcode to your revised list, simply click the Add New button and type the details in.

Interstate or overseas users who do not require all Australian suburb names or postcodes, you have the
option to remove the entire list and enter your own list from scratch.

.
To remove all entries from the suburbs list:

1. Click the Remove All button in the Suburbs and Postcodes section in Preferences.

2. When you do this, the a warning appears. This is just to make sure nobody accidentally
deletes the whole list, but if you are sure, click Yes and then go to the Suburb and
Postcode Maintenance window and start adding your own.

18.8 Setting up PawnShop to run over a network

  NOTE: Unless you are very comfortable using Windows Explorer, it is
recommended that you let the people installing your network do this for
you.  The language is technical.

PawnShop was designed to be run over networks supported by Windows 98, NT 4.0, ME, XP and 2000. To
do this, you will need to have your computers connected to each other. Only one computer on your network
will actually contain the PawnShop database. You will have to decide which computer you would like to have
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it on.

Once you have decided, you will need to connect the slave computer(s) (i.e. the one(s) which won't contain
the database) to the master or server (the one which does hold the database). This terminology will be used
throughout this documentation. Please note that you can have more than two computers on your network.
You will always have one server, but can have more than one slave computer.

To share the server drive so that other computers can see it:

1. Open Windows Explorer.

2. Click the right mouse button on the drive that you wish to share. This will usually be the C:
drive.

3. A menu will appear. Choose Sharing… from this menu.

4. Click on Shared As and make sure the drive letter is in the Share Name box.

5. Click Full as the Access Type. Do not use a password.

6. Click OK.

Now that you have shared the drive so that other computers can see it, you can tell the slave computer to
look at the server drive.

To connect a drive from the server to the slave:

1. Open Windows Explorer.

2. Choose Map Network Drive… from the Tools menu.

3. The computer will allocate the next available drive letter for you. Type the path of the server
along with the share name.

4. Make sure that the Reconnect at Logon box is ticked.

5. Click the OK button.

By doing this, the slave computer will see the server's hard drive as if it were its own.

The next step to using PawnShop over a network is to tell the slave's version of Pawnshop to use the copy
of the database on the server.

  NOTE: By default, PawnShop will use the database located in the same folder
as the program when you installed it. We now want it to look at our
server's drive for the database instead.

To change the location that PawnShop looks for the database:

1. Make sure that the server is started, the network has been connected and you have set up a
drive connection as outlined above.

2. Open PawnShop on the slave computer.

3. Choose Preferences… from the Options menu.

4. Click on the General tab.

5. Change the entry in the text box next to the Browse… button in the Database & Backups
frame to match what this computer sees the server database as. For example: If you connect
the server drive to the slave computer as drive F: and the Pawnshop database resides in
C:\Program Files\PawnShop on the server, the slave will see this as F:\Program
Files\PawnShop.
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6. You can use the Browse… button to find the pawn99.mdb file on the server if you do not
know the exact location.

7. Click the OK button to save the changes to the preferences.

8. Close PawnShop and restart. The program should then use the server file as its database.

  NOTE: The server must be turned on before running PawnShop on the
slave(s). If you turn them on in the reverse order and start PawnShop
on the slave computer first, you will get a message saying that the
database cannot be found, and you will be asked if you wish to restore
a backup. You will also be asked this question if there has been a
problem with your network. This problem could be faulty cables,
network cards or either the server's or slave's hard disk. Answer No to
this question. If you answer Yes, your slave computer will look for the
database on its own hard drive rather than on the server's. This
problem will be addressed in a future update of PawnShop. You can get
around it by always turning the server computer on first.

18.9 Export Clients and Contracts

Sometimes you may wish to import your client list into a word processor program to do a mail out to all of
your clients. Or you may wish to load all items into a spreadsheet. There are three menu items that export
your data to text files to allow you to do this.

Under the File menu, you will see the Export Clients…, Export Contracts… and Export Client Notes...
menu items.  These will export all clients, contracts and notes respectively to a file location that you specify.
Please note that they will export all client and contract records, so the files may be quite large and it may
take a moment or two to complete.
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